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ABSTRACT 

This report, prepared for the Town of Brookline's Parks and Open Spaces 
Division, investigates the American with Disabilities Act (ADA) and how it pertains to 
Brookline’s park and open spaces.  The guidelines described by the ADA were used in 
conjunction with the Geographical Information System that was implemented to evaluate 
the position of Brookline with the ADA's guidelines.  The information provided by the 
team will enable Brookline to assess the feasibility of the need to develop a proper 
maintenance plan for its parks and open spaces to ensure ADA compliancy. 
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EXECUTIVE SUMMARY 

 Compliance with The American with Disabilities Act has been a problem for 

many organizations since its enactment in 1990.  Any structure that is being renovated or 

being built must comply with the guidelines stated by the ADA.  However, these 

guidelines are only guidelines and are open for interpretation because they are still in 

debate.  There have not been any regulations that have been passed.   

In Brookline, some parks have been renovated and have been built according to 

the guidelines provided by the ADA, but there have still been some complaints because 

of elements that are not in compliance.  The current way of discovering if there is a 

compliancy issue is to hire an outside consulting agency to come to the site and 

investigate the park to see if there is an issue.  This is a costly process for the town of 

Brookline and can be avoided if they understand the guidelines and are knowledgeable of 

what each park and open space contains. 

            Our goal was to assist the Town of Brookline's Parks and Open Spaces Division 

in their processes for complying with the ADA.  We implemented a database and 

Geographical Information System (GIS) to aid in this decision making.  The database 

software that we utilized was Microsoft Access and the GIS system that we utilized was 

ArcGIS.   

            Using these technologies, we were able to study a park or open space and observe 

its contents (benches, picnic tables, trash barrels, etc.).  By utilizing different layers in the 

GIS software, we can see the locations of all the items and whether or not they are on an 

ADA accessible path.  An ADA accessible path is one of the most important required 

elements in a park; thus, it is important to visualize it on the maps. In addition to this, we 
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can observe each individual element and see attributes such as its condition as well as if it 

is ADA compliant.    

            In order to learn about GIS, the first few weeks were dedicated to inventorying 

the smaller parks of Brookline and entering the information into the Access database and 

plotting it in the GIS system. Once we had done this for a park, we would double-check 

the park and make sure we had entered in the appropriate data that needed to be 

inventoried.   

Once we had completed several parks, we researched heavily into the ADA.  The 

two most important documents that we used were the Regulatory Negotiation Committee 

on Accessibility Guidelines for Outdoor Developed Areas – Final report, which was 

published by the ADA commission in 1999 and the ADA Accessibility Guidelines for 

Play Areas, which was published by the ADA commission in 2000. 

            During our ADA research, we also interviewed the ADA Coordinators of the 

cities of Boston, Cambridge and Newton to inquire as to how they manage the ADA and 

how they incorporate GIS into their every day activities and decisions.  In addition to 

these cities, we also interviewed the head of the ADA Commission of Brookline to 

inquire about the current system of how Brookline deals with the ADA.   

            With the knowledge that we gained we are recommending that the town of 

Brookline establish a proactive approach to the ADA.  Currently the position of 

Brookline is that it is “100 percent compliant until there is a compliant” (Stephen 

Bressler, Brookline ADA commissioner).   Based on interviews with the towns and cities 

of Cambridge, Newton and Boston, we believe there is room for improvement.  In 

addition to the outside agency, Brookline has to investigate the issue in order to confirm 
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the complaint is tangible.  There is a chance of a lawsuit if someone were hurt because of 

the issue, as well as the cost of fixing the problem in order to comply with the ADA 

guidelines.  The benefit of a proactive approach can easily be seen because it would result 

in fewer complaints. With fewer complaints, the town will have to hire an outside agency 

to evaluate the parks less often. Furthermore, redesign and redevelopment is a costly 

process that could be avoided by doing things right the first time. 

           We also recommended that the town of Brookline consults with Boundless 

Playgrounds. Brookline has a lot of work to do to become compliant, but we feel that 

being compliant is not enough. Working with the nonprofit organization will ensure that 

the parks and playgrounds are not only accessible, but also fun and easy to use for 

everyone—with or without disabilities. The playgrounds will be transformed into places 

where children of all disabilities can socially interact and develop, and no one will have 

to feel left out. 

Currently, the Brookline ADA grievance form is not easily obtainable. We have 

found that other towns and cities have their grievance forms located on their websites. It 

would be much easier for the citizens if Brookline's grievance form were located on the 

town website. This would allow citizens to access the form at their convenience and 

enable them to file complaints immediately.  
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INTRODUCTION 

 Access to a clean, safe, and proper park is desired by the population in most 

towns and cities. Today’s society emphasizes indoor recreation, but parks provide an 

invaluable opportunity to breathe fresh air, meet people, and provided a social setting for 

children to interact with each other. Parks not only provide visual and recreational assets 

to communities but also help to improve land value, city image, and health. In a study 

published by the CDC (2001), they found that the percentage of people who exercise 

increased by 25.6 percent when there was access to a place for physical activity. Sjerp de 

Vries (2001) found that people who live in greener environments will complain less 

about their health, and feel healthier both physically and mentally. An extensive report 

completed in 1996 by the U.S. Surgeon General found that when people perform regular 

physical activity they benefit from reduced risk of premature death; reduced risk of 

coronary heart disease, colon cancer, hypertension, and non-insulin-dependent diabetes; 

continued muscular strength, better joints, as well as countless other benefits. (CDC, 

1996) 

 Parks also play a large role in youth development by giving the community’s 

younger generations opportunities to enjoy physical activities and social interaction in a 

safe and productive environment. “Research on the brain demonstrates that play is a 

scaffold for development, a vehicle for increasing neural structures, and a means by 

which all children practice skills they will need in later life.”(TPL, 2006) In a time when 

public funds are limited, people are demanding an increase in funding for parks and open 

spaces. In November of 2002 voters in ninety-three communities in twenty-two states 

voted in favor of a combined $2.9 billion to acquire new public open spaces. (LTA, 2002) 
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Parks also gives the older populations a place to participate in activities like bike riding, 

walking, running, site-seeing and playing frisbee. 

 In an ideal world, every city would have parks that are safe, up to date and 

accessible by healthy and disabled citizens alike. There is no doubt that every community 

would benefit from and enjoy a park such as New York City’s famous Central Park; 

however, many communities cannot reach this goal because of budget constraints and 

lack of community effort among other things.  

Parks must be designed and redesigned for the surrounding population. In order to 

accomplish this, demographic and population data should be considered. Over the years, 

parks may become outdated. Communities need to plan on parks that will dynamically 

change over the years, just as the population does. For instance, a park that was 

developed several years ago in a community primarily inhabited by families with small 

children may now be inappropriate because the children have grown up. 

 In order for local governments to maintain their parks properly, they need to know 

what equipment is currently in their parks, where it is, and what condition it is in. An 

efficient solution to this problem is a well-maintained inventory database. An inventory 

database theoretically would allow the local parks departments to evaluate quickly where 

the immediate need for money is located throughout the parks. The utilization of a 

geographical information system (GIS) would help tightly integrate all of the data by 

showing what equipment each park has and the position of the equipment in each park. 

 The town of Brookline, Massachusetts, for example, is an affluent town that is 

consistently investing money into upgrading and maintaining its open spaces. Brookline 

currently has one of the most advanced GIS in use today (Feng Yang, Brookline GIS 
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Administrator) and it is currently utilized in other town operations. Officials have seen 

the benefits of GIS and now want it to be incorporated into their program aid in ADA 

compliancy, an inventory management system, as well for future projects such as a waste 

refuge plan.   These technologies will also allow Brookline to be able to see where its 

money needs to be spent, and how to utilize its money efficiently.  

The purpose of this project was to further improve the overall park management 

system. To accomplish this it was necessary to take several different approaches. The 

first was to update the existing database with the most recent information we collected 

from our visits to the twelve parks. After this we then began to create the framework for 

GIS layers that would represent all the features in the parks. With the database being 

established prior to this project it was necessary to build the frameworks for the GIS 

layers around that of the database. We created appropriate GIS layers to display the 

inventory visually, and creating these layers turned out to be very intricate and time 

consuming. Not knowing who would be continuing our work, we created a simple 

manual that outlines all the steps needed in order to create the proper layers in ArcMap 

(See Appendix B).  

Once we had an understanding about Brookline’s parks and what elements were 

contained in them, we then looked at a way to improve the management of ADA 

grievances as well as overall compliancy within the municipality. To accomplish this it 

was necessary to become familiar with the guidelines and regulations published by the 

state and federal government.  After interviewing many of the town and city officials as 

well as investigating it first hand, we found these documents to be complicated and 

unclear. During our research we outlined the most important information and have 
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compiled it to be used as a reference. (See Appendix H) Our ADA research goes far 

beyond this and will be discussed in further detail later. 

A “great park” does not necessarily mean a park with state-of-the-art equipment, 

or the greenest grass or even the best location.  The true standouts are the parks that 

define the identities of their cities, which tend to share certain elements that, together, 

explain a great deal of their success. 

An example of a park that does this is Pioneer Courthouse Square located in 

Portland Oregon.  Portland Courthouse 

Square, nicknamed “Portland’s Living 

Room” is a part of the Portland Parks 

Department even though there is not one 

blade of grass growing there.  The 

nerve center of downtown Portland.  Its 

popularity stems from its central location and the 300 separate events it hosts every year. 

According to Madden (2004), the attraction of the square can also be attributed to its 

close proximity to the transit system, good management, and multiple funding sources. 

The park boasts a Starbucks that assists in funding the park while reputed as being the 

largest-grossing Starbucks in the country (PPS, 2006). Having multiple revenue sources 

allows the management to constantly look to improve the park without being dependant 

on government funding. 

Figure 1 - Starbucks in Pioneer Courthouse Square 

Square’s role as transit hub makes it the 

 One of the most famous parks in the world, Central Park is the type of park that 

tries to serve every facet of the community. Central Park, located in New York, NY along 
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with Prospect Park located in Brooklyn, NY serve as examples of parks that run by an 

extremely successful management system. Their management system is described by 

Madden (2004) as “superb,” credits the parks’ “flexible design” which accommodates 

numerous activities during all seasons. The many organizations involved with the parks 

enable the implementation of complex restoration projects, capital improvements, 

maintenance programs, and event schedules.  

Madden (2004) also names Plaza Hidalgo in Mexico City, Mexico for its flexible 

design which enables its wide assortment of amenities that act as the centerpieces of the 

park.  Such amenities include market stalls, benches, and small fountains under trees 

where people typically congregate, and scattered throughout the park are vendors selling 

fresh lemonade and other treats.  

A parks’ identity is the basis of its success.  Boston’s own Public Garden is 

acknowledged for its excellent attractions which provide a strong identity for itself and 

the city (Madden, 2004).  The "Make Way for Ducklings" sculpture located in the Garden 

that honors children's author Robert McCloskey leaves an everlasting impression on the 

children and families.   

 The theme of what makes a great park “great” seems to boil down to two basic 

elements, the level of its management system and whether or not the park brings identity 

to its location. The identity of the city that the parks system brings can be a positive one 

but it could also be a negative one if the parks are crime ridden and run down. Of the fifty 

large U.S. cities surveyed by TPL in 2003 approximately half collected crime statistics in 

and around their parks. Of these that did collect data only a hand full had a plan to use 
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this information. Every park system should have a plan to evaluate and handle crime 

within their parks. The best way to deter crime within parks is to increase usage.  
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BACKGROUND 

 In order for our project to have an impact on Brookline it was necessary to 

become familiar with the town.  In doing this, we investigated the various advantages and 

disadvantages parks bring to Brookline.  These parks also must accommodate the 

disabled by following The Americans with Disabilities Act (ADA).  The following 

chapter will highlight the importance of these subjects.  

History of Brookline 

 Looking at the customs of Brookline will give one the general feeling of how and 

why they value their parks. The Town of Brookline, Massachusetts was incorporated in 

1705 and is bordered by Boston and Newton. Currently, it is run by a representative town 

meeting and the executive branch of the government is run by a board of five selectmen 

that are elected on a rotating basis.  

Outdoor recreation has a history in Brookline; it is home to the first private 

country club in the nation known as The Country Club and it has hosted the US Open 

three times and the Ryder Cup once. Due to its proximity to Boston it is a very 

convenient place for commuting to Boston. The M.B.T.A. (Massachusetts Bay Transit 

Authority) has multiple stops in Brookline which provides easy and convenient access to 

Boston for those commuters and residents as well. 

 Brookline is a predominantly white town. At 81 percent (US Census, 2000), 

Caucasians make up the vast majority of the town’s population with the Asian population 

at 12.8 percent and the African American population totaling 2.7 percent (US Census, 

2000). The median household income is rather high at $66,711 (ePODunk.com, 2001). 
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This can most likely be attributed to 77 percent of the population age 25 and older having 

a Bachelor’s degree or higher (ePODunk.com, 2001). Having a large median income like 

that allows the departments in the city to have a more flexible budget.  

 Brookline is a town full of character and has a lot of history and culture distinct 

from Boston. In a suburban setting, it features many nice shopping areas, recreational 

parks, large homes, and modest apartments. Brookline has a density of about 8,409.7/mi² 

which makes it a dense population. With the dense population comes the shrinking of 

resident’s personal yards. This could be a reason for the overall sense of ownership 

among Brookline residents towards their parks. Brookline is also home to the “Fairsted”. 

The “Fairsted” is a 100-year-old home of the famous architect Fredrick Law Olmsted and 

the Olmsted Brothers firm. This is such an important landmark to Brookline that it is now 

the Frederick Law Olmsted National Historic Site. Even historic sites like the Olmsted 

National Historic Site are part of the Parks and Open Spaces department of Brookline. 

Appendix I shows the numerous parks and open spaces scattered throughout Brookline. 

For being a geographically small town, the number of parks is high and the history of 

parks and open spaces in America can be traced back to Brookline. Frederick Olmsted 

was the landscape architect for Central Park as well as numerous other parks in the 

Americas and Europe.  

Why Do We Need Parks? 

 Parks provide many benefits, some of which are not so obvious. Many will agree 

that there are several health benefits associated with parks and other recreational 

facilities, because it is common sense that any extra physical activities promote better 

health. However, there are other, not so apparent, benefits offered by parks. For instance, 
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parks can provide a social setting that may not be available in work or academic settings. 

In addition, studies have shown the impact on the economy and environment afforded by 

parks (Sherer and The Trust for Public Land, 2003) (The Trust for Public Land, “Benefits 

of Urban Open Space”). 

Health Benefits 

 Today, parks are vital to sustaining a healthy community. Obesity among U.S. 

adults between the ages of 20 and 74 was at 15 percent in 1980. Obesity among the same 

age group in 1999 was found to be at 27 percent according to the CDC. Parks have 

evolved from a place for children to play to a place where children and adults alike go to 

play and exercise. When a community has better access to parks and recreational 

facilities, more people will exercise. A study published by the Centers for Disease 

Control and Prevention (CDC) showed that the creation or enhancement of places for 

physical activities led to an increase of 25.6 percent in the number of people exercising 

three or more days per week (CDC, 2001). Studies reviewed in the American Journal of 

Preventive Medicine support this by saying that the “creation of or enhanced access to 

places for physical activity combined with informational outreach” resulted in 48.4 

percent increase in the frequency people exercise. 

 Studies have shown that parks not only enable people to exercise more and enjoy 

more leisure activities, but also have an effect on psychological health. One such study 

found that in a greener environment people report fewer health complaints, more often 

rate themselves as being in good health, and have better mental health (de Vries et al, 

2001). The colors, shapes, textures, and smells that nature creates can be some of the 

most peaceful and enjoyable things on earth. When the medical records spanning ten 
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years were reviewed it was found that patients with trees outside their window had 

shorter hospitalizations, and less need for painkillers when compared to patients who had 

brick walls outside their windows. (TPL, 2003) 

Economic Benefits  

 Studies have shown that property that is closer to parks and green space has a 

higher value than property that is not. Since parks are more pleasant than rundown 

buildings, highways, and other common structures in urban environments, some people 

prefer to buy homes that are close to parks and open spaces. A study done in Boulder, 

Colorado examined the effects of greenbelts on residential property values. A greenbelt is 

defined by Merriam-Webster as a belt of parkways, parks, or farmlands that encircles a 

community. This study found that there was a $4.20 decrease in the price of residential 

property for every foot one moved away from the greenbelt, and that the average value of 

homes next to greenbelts was 32 percent higher than those 3,200 feet away (Sherer and 

The Trust for Public Land, 2003). 

 Parks also help attract and retain businesses. Towns and cities with more parks 

and open spaces afford a higher quality of life and attract better people, which in turn 

attract better businesses. For instance, many new companies picked Portland, Oregon 

because their employees preferred its quality of life (TPL, n.d.). Bill Calder, a spokesman 

for Intel, says “Companies that can locate anywhere they want to will go to places that 

attract good people” (TPL, n.d.). 
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Environmental Benefits 

 The environmental benefits of parks are dramatic. The main benefits observed are 

the management of storm water runoff, decreased energy consumption, and improved air 

quality. The U.S. Forestry service determined that over the span of fifty years one tree 

can generate $31,250 worth of oxygen, control air pollution worth $62,000, recycles 

$37,500 worth of water, and controls soil erosion worth $31,250.  

 Parks and open spaces can more effectively control storm water runoff. 

Urbanization of towns results in a reduction of green space and an increase in the number 

of impervious surfaces such as parking lots, roads, and sidewalks. Because of this, storm 

water must be managed in another way; sewers, storm drains, and drainage ditches must 

be built. This is a long and costly process. It also costs more in the long run because it 

must be maintained. Pervious surfaces are a better solution to managing water runoff and 

also offer other benefits. Excess water from storms is absorbed into the soil, which is then 

used by the various plants for nourishment. Through this process, the storm water is 

purged of many pollutants, such as nitrates, phosphorous, and potassium. (Keating, n.d.). 

There is also an economic benefit to reducing storm water runoff. A study done in 2000 

(Beattie, Kollin, Moll) in Garland, Texas found that its existing trees handle 19 million 

cubic feet of storm water. Facilities to manage an equivalent amount of water would cost 

$38 million. 

 Trees are also known to reduce residential energy costs. They provide shade for 

houses and are most effective when placed near air conditioners, windows, and walls. 

They are also more effective when shading the areas receiving the most exposure to the 

sun. A study done by American Forests (2001) found that tree cover in metro Atlanta 
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accounted for an annual savings of $2.8 million for residents. In a study, the evaporation 

from a single tree can produce the cooling effect of 10 room size air conditioners running 

20 hours per day (U.S. Department of Agriculture, n.d.). 

 Trees have an important role in the reduction of air pollution. They remove 

pollutants from the air such as nitrogen dioxide, sulfur dioxide, ozone, and carbon 

monoxide (American Forests, n.d.). In 1994, Nowak found that trees in New York City 

removed an estimated 1,821 metric tons of air pollution, with an estimated value of $9.5 

million. Similarly, trees account for a savings of $2.1 million in Washington, DC, $47 

million in Atlanta, GA, $4.8 million in Portland, OR, and $2.6 million in Denver, CO 

(American Forests, n.d.). 

The Americans with Disabilities Act 

 Legally, parks have to meet certain regulations to accommodate their public. The 

American with Disabilities Act was passed by the United States Congress in 1990 in an 

attempt to stop discrimination against Americans with disabilities.  The ADA states 

specific guidelines that need to be met so that non-discriminatory acts occur.  The ADA 

as a whole is a very complicated and intricate document covering all accessibility issues 

of where, for example a medical building and how many ramps per entrance are 

appropriate for that particular building should be addressed.   

 There have also been complications regarding what exactly is “disabled” and who 

is considered disabled?  As defined by the ADA, the term “disability” means with respect 

to an individual: “A physical or mental impairment that substantially limits one or more 

of the major life activities of such individual.” Contrary to what most think, the ADA has 

also defined an individual with a disability to include individuals with contagious and 
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non-contagious diseases such as HIV, epilepsy, cancer, heart disease, tuberculosis, and 

alcoholism (The Americans with Disabilities Act of 1990,  01/15/97). 

 Under the Americans with Disabilities Act, parks fall under Title III: Public 

Accommodations.  A place of public accommodation is a facility owned by a private 

entity that either operates, leases, or leases to a place of public accommodation whose 

operations affect commerce and fall within certain categories (ADA Questions & 

Answers, 10/07/2003).  One such category includes a park, zoo, amusement park, or 

other place of recreation.  Within these categories fall various departments.  Park 

management is located in the Department of Interior which includes all programs, 

services, and regulatory activities relating to lands and natural resources, including parks 

and recreation, water and waste management, environmental protection, energy, historic 

and cultural preservation, and museums.   

 The details of the ADA can become confusing; a representative from the 

Brookline Parks and Recreation Department, Tom Brady expressed such uncertainty 

when interviewed (January 24, 2006).  He explained that the ADA just has far too many 

technicalities and stipulations.  In order for the Brookline Parks and Recreation 

Department to make sense of the guidelines they are looking to create a separate policy 

for each of the different kinds of parks located in Brookline.  Often, the Brookline Parks 

and Recreation Department tries to understand what exactly is needed for the parks but 

often finds it hard to get a clear answer due to its complexity and lack of precise 

requirements. For example, the following table shows the relationship between required 

accessible ground-level equipment to elevated equipment. 
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TABLE 1: NUMBER AND TYPES OF GROUND LEVEL PLAY 
COMPONENTS REQUIRED TO BE ON ACCESSIBLE ROUTE 

Number of Elevated 
Play Components 

Provided 
Minimum Number of Ground Level Play 

Components Required to be on Accessible Route 

Minimum Number of 
Different Types of 
Ground Level Play 

Components Required 
to be on Accessible 

Route 
1 Not applicable Not applicable 

2 to 4 1 1 
5 to 7 2 2 

8 to 10 3 3 
11 to 13 4 3 
14 to 16 5 3 
17 to 19 6 3 
20 to 22 7 4 
23 to 25 8 4 

More than 25 8 plus 1 for each additional 3 over 25, or 
fraction thereof 5 

(“Making Playgrounds Accessible”, 2005) 

 Another problem lies in the design process of parks and playgrounds.  Many times 

the designer does not take into account the essential parts in creating an appropriate place 

for individuals with disabilities.  Something as simple as bark chips makes it impractical 

for a wheel chair to be mobile.  Other designers’ problems include making the 

playground itself accessible; many require cutting through grass or “natural terrain” to get 

to the play structure. Cutting through the natural terrain often times degrades the overall 

quality of the natural setting. The next issue arises with the contractors because in general 

contractors do not like to take on the accessibility dilemma. 

 A third issue that frequently arises when assessing ADA compliancy is when an 

issue does exist, who is responsible for fixing it? Repairs can be quite costly. Therefore 

ADA compliancy should be implemented in the planning stages. Investing money into 

work that will need to be fixed at a later date is futile. Municipalities can easily save 

money by consulting third party organizations to make sure that all requirements of ADA 
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are covered in the initial stages. Brookline, Massachusetts does this quite frequently with 

an organization called Adaptive Environments. (http://www.adaptenv.org/) Adaptive 

Environment is used to ensure that the work they do is also in accordance with the ADA. 

This company is non-profit and has the sole intention of helping the public and private 

sector make the right choices. In speaking with Juanita Mincey, Disability Program 

Specialist for the City of Boston, she showed the utmost respect and admiration for 

certain individuals within Adaptive Environments as well as the company itself.  

 There are many other organizations that are similar to Adaptive Environments 

such as Boundless Playgrounds (http://www.boundlessplaygrounds.org/). Within 

Brookline we found many of the parks to be well on their way to ADA compliancy. 

Many of the ADA issues arose in terms of the play structures themselves. Consulting 

Boundless Playgrounds would have ensured that the play structures would be accessible 

by all.  Boundless Playgrounds is a nonprofit organization headquartered in Bloomfield, 

Connecticut. It was founded in 1997 by a passionate team of parents and professionals 

and has since been dedicated to helping communities create extraordinary playgrounds 

where all children can develop essential skills for life as they learn together through play. 

At the time of this writing, there are over seventy-five Boundless Playgrounds in twenty-

one states and provinces with dozens more in development. 

 Parks aim to please its public and to be utilized as much as possible.  The ultimate 

goal of most park facilities is to meet the ADA standards, and to satisfy its public, but the 

complications of the requirements inhibit them from accomplishing this goal. 
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METHODOLOGY 

The purpose of our project was to better Brookline’s Parks and Recreation 

Department by establishing a methodology for inventorying parks, updating the database 

and starting the implementation of the GIS system. These tools then can be used to 

further ADA compliance within the parks and open spaces.   

Inventorying of Selected Parks 

 The first step of this project involved the inventorying of twelve parks in the town 

of Brookline. We went to each park with an aerial map of the park and a field book. 

Using the map, we recorded the locations of all the equipment. We decided to use a 

number system. Each item was given a specific number, which was then used as a 

reference in the field book. This inventory included all equipment, paths, utilities, and 

fences, as well as the current condition and location of each item. The condition was 

recorded (poor, fair, good, or excellent) relative to other equipment we witnessed 

throughout the park system. Other attributes were also recorded, which included the type 

of equipment (toddler swing set, chain-link fence, climbing structure, etc.) as well as 

various type-specific attributes.  

GIS Map Layer Creation 

 For each park inventoried, a GIS map was created. This involved creating the 

necessary layers and adding the appropriate icons and lines to represent the data. Most 

elements required an icon to be placed at their corresponding location, whereas others 

required lines and polygons to be drawn on the map.  
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A link was needed between the items on the maps and the data. To do this, each 

item on the map was assigned an ID which corresponded to the database. This link is 

crucial and makes the maps much more useful. 

These newly created maps will help Brookline by giving an overhead view of the 

parks and also aid in analyzing the data. With a GIS map, park officials will be able to 

see the location of their equipment, along with current conditions and other relevant data. 

This will act as a tool for maintenance and replacement decisions, the development of a 

new refuse management plan, and a plan for ADA compliance. 

For more information, refer to Appendix B of this document.   

Americans with Disabilities Act 

Complying with the Americans with Disabilities Act (ADA) can become 

extremely difficult according to Tom Brady (1/24/2006).  One of our goals of the project 

was to help simplify the ADA’s guidelines so that the town of Brookline can easily abide 

by their regulations. This has been accomplished by numerous interviews from ADA 

coordinators from surrounding towns and cities. In addition to these interviews there has 

been work put into developing simplified versions of two federal ADA guidelines.  These 

simplified guidelines can now be used as a reference by Brookline or any other 

municipality.  
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DATA AND ANALYSIS 

 In order to fulfill our objectives, we gathered data from twelve parks in Brookline 

and used this data to determine the current state of ADA compliance. We found it 

necessary to first become familiar with what comprised a park. Only after then could we 

begin reviewing the guidelines and associating them with particular issues within the 

parks. We found issues within even the most recently renovated parks of Brookline. With 

these issues we were able to provide examples of why a proactive program is necessary 

when dealing with ADA problems. We have also interviewed the ADA coordinator of 

Brookline and the surrounding towns and cities in order to compare the different policies 

currently in use. With this information, we have combined the best practices of Boston, 

Brookline, Cambridge and Newton to compile what we believe is the best practices that 

should be used by all municipalities. 

Classification of Parks 

 To determine the accessibility of each individual park, it was necessary to use our 

research into the ADA to examine what was compliant with the ADA and what was not. 

 In addition to Brookline we investigated Boston, Cambridge and Newton to learn about 

their different approaches to complying with the ADA.   

Park 1: Lawton Playground – Brookline, MA 

 Lawton Playground is a one acre park located on Lawton Street in Brookline. 

Lawton Street separates two lots of nearly equal sizes. The north side is primarily used 

for its basketball court and sunbathing, while the south side has a playground primarily 
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used by younger children. Within the park there are two play structures, sandboxes, and a 

spray pool. The park was last renovated in 1990, ten years before the Accessibility 

Guidelines for Play Areas were published. This renovation included two new play 

structures. We have found most of the elements in Lawton Playground to be in violation 

of these guidelines. 

Outdoor Guidelines 

 All the outdoor recreation access routes in the Lawton Park are fully ADA 

accessible.  The outdoor recreation access routes are asphalt, so they are firm and stable, 

and they average between 40 to 60 inches in width, which complies comply with 16.3.2 

(Clear Tread Width) of the ADA guidelines.  The terrain is mostly flat, so there are no 

requirements for resting 

areas (Appendix H, 

Section16.3.7.2.1).  The 

rest of the guidelines are 

met for outdoor 

recreation access routes, 

except that the access 

routes show signs of age 

and need to be fixed. Figure 2 -  Bench in Violation due to lack of armrests 

  All the trash containers are ADA compliant as stated in 16.8 (Fixed Trash/ 

Recycling Container).  There are two trash barrels in total, and both are placed along an 

outdoor recreation access route.   
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 There are a total of twelve benches at Lawton Park, which means that six of them 

need to be ADA accessible.  After inspecting the park, none of them are.  Fifty percent as 

required by 16.12.1.1 (Multiple Benches) of the six accessible benches need to have 

armrests, but none of the benches in the park do, please refer to Figure 2. Brookline needs 

to install new benches that have arm rest to comply with 16.12 (Benches).  If there were 

accessible benches installed, all the other criteria for 16.12(Benches) would be passed. 

 There was one picnic table located near the pre-teen play area of the park (Figure 

3). Section 16.5 (Fixed 

Picnic Tables) of the 

guidelines state that if there 

is only one picnic table, it 

must be accessible, and the 

one in this park is not.  All 

four sides contain a bench, 

and there is no space for a 

person in a wheel chair to 

be able to come up and sit 

at the table as required by Section 16.5.  In order for Brookline to comply with this 

guideline, they must upgrade their picnic to one that is accessible and follows the 

guidelines stated in 16.5. 

Figure 3 - Non-accessible picnic table due to lack of required space 
for wheelchairs 
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 The transitions from one type of pathway to another were in good condition as 

seen as Figure 7. There was very little change in elevation where the two surfaces meet, 

much less than an inch, and can barely be felt.  

 

Figure 4 – Example of a compliant change in surface types 

 

Play area compliancy 

 Lawton has several different play areas, most of which do not meet the guidelines. 

The pre-teen play area has several problems. This play area has one composite structure, 

which is comprised of two slides, a play panel, a steering wheel, stairs, and a climbing 

component. Because this structure has less than twenty elevated components, no ramps 

are required; however, at least fifty percent of these components must be off of an 

accessible path and connected by a transfer system or ramps. Figure 8 shows this 

structure. 
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Figure 5 - Composite Climbing Structure 
 

 There are two main problems with this structure: the elevated components are not 

accessible and there are no ground-level components. In this case, there is a ramp, but the 

ramp itself is not compliant. The ramp must be a continuation of the accessible path, but 

this cannot be fulfilled because there is no accessible path leading to the ramp. In 

addition, the entrance to the ramp is not flush with the path. The handrails of the ramp 

have compliancy issues as well. The rails must have horizontal gripping surfaces on both 

sides of the ramp. The tops of these surfaces must be between 20 and 28 inches above the 

ramp surface. The picture shows that these handrails do not have gripping surfaces that 

meet these parameters. The lack of a proper ramp or transfer system restricts the use of 

this structure to children that have no disabilities. 

 The guidelines specify how many ground-level components must be on an 

accessible route based on how many elevated components exist in the play area. This 

play area has six elevated components. In order to be in compliance, it would be required 

to have two ground-level components, each of a different type. 

 32



 The toddler play area has some problems as well. This area contains ground-level 

components and a composite structure with elevated components. The elevated 

components in this area are not accessible either. This structure also utilizes a ramp to 

provide access to the elevated components. This ramp is noncompliant, but for different 

reasons. Figure 6 shows this ramp. The ramp is noncompliant for two reasons: the slope 

and the handrails. The slope is 

required to be no greater than 

1:12. The slope of this ramp is 

much greater, 1:4.  To be in 

accordance with the ADA, for 

every 12 inches a ramp goes 

forward, it can only rise one inch, 

and in this photo, the ramp only 

goes four inches before it 

changes elevation by one inch. Although these handrails offer gripping surfaces, these 

surfaces do are not at the correct height. It is apparent that this ramp was not designed for 

children in wheelchairs. 

Figure 6 - Non Compliant Ramp 

Park 2: Coolidge Park – Brookline, MA 

 Coolidge Park is a community park located on Columbia Street.  It is a 1.68 acre 

park that contains a basketball court, tennis court, spray pool and two playgrounds 

containing swing sets, climbing structures, and a sandbox.  Also, the park has a lighted 

and fully paved pathway as well as trash containers and benches throughout the park.  
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Outdoor guideline 

All the outdoor recreation access routes in the park are fully ADA accessible.  

The outdoor recreation access routes are asphalt, so they are firm and stable, and they 

average around 72 inches in width.  This complies with not only Section 16.3.2 (Clear 

Tread Width) of the ADA guidelines, but also Section 16.3.6 (Passing Space) because the 

path is over 60 inches wide.  The rest of the guidelines of Section 16.3 are compliant with 

Coolidge’s outdoor recreation access routes.   

According to Section 16.8 (Fixed Trash/Recycling Containers) all trash containers 

must be on an accessible path, and the trash barrel in Figure 7 is not on located on an 

accessible path on Kenwood Street next to the bulletin board.  

 

Figure 7 - Non Complaint Trash Can 
 

The path is not firm or stable going to it, and also it does not comply with Section 16.3.5 

because where there is a change in surface types, the dirt and the concrete, it is a greater 
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than one inch change in elevation between them, please refer to Figure 7. Section 16.3.5 

states that the change must be less than an inch, otherwise a ramp has to be installed. 

Besides this one trash barrel, all the other barrels are fully compliant with Section 16.8.  

In order to make the barrel compliant, it needs to be moved next to the path, and have the 

opening of the barrel face the path. 

 In total, there are fifteen benches in Coolidge Playground, and it is requires that 

eight of those benches be ADA accessible throughout the park, and four of those need to 

be located on a main access route.  All of the benches throughout the park are accessible 

according to the ADA guidelines in Section 16.12.  Although the benches around the 

toddler play area and the tennis courts do not have armrests, this is allowed by the ADA 

guidelines because it states only 50 percent of the benches that are accessible need to 

have arm rest.  

 Also, all of the benches have the proper clear space, Figure 8, proper front edge 

height of the seat, Figure 9, and comply with all the guidelines of Section 16.12. 

 

Figure 8 - Proper Clear Space Around Benches 
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Figure 9 - Proper Bench Height 
 

The last outdoor element that is found in the park that deals with this section is 

that of the water spout.  Section 16.16.3 of the guidelines requires that all fixed water 

spouts (drinking fountains) are located between 28 and 36 inches off the ground and are 

required to be centered at the edge of a minimum 60 inch by 60 inch clear space.  The 

water spout that is shown in Figure 10 and 11 is compliant with ADA because it has a 

height of 35 inches and the path that it lies on is 160 inches wide, which is more than 

what is required by the guidelines. 
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Figure 10 - ADA Compliant Fountain 
 

 

Figure 11 - Space surrounding this fountain is sufficient 
 

 

 

Play area compliance 

 A better example of compliancy is 

the recently renovated Coolidge 

Playground. This playground exhibits only 

minor compliancy issues. Figure 12 shows 

a transfer system that has been correctly 

designed to enable access to the elevated 

components. This composite structure is 

located in the toddler play area. In order for 

Figure 12 - Transfer System 
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a transfer system to be compliant, the transfer platform is required to have a height 

between 11 and 18 inches. It must also have a depth of at least 14 inches, and a width of 

at least 24 inches. This platform meets these criteria. The transfer steps leading to the top 

of the structure must be no greater than eight inches tall, at least 24 inches wide, and 14 

inches deep. These steps also meet the requirements. Transfer supports are also required 

in a transfer system. They include handrails, handgrips, or handholds. Figure 12 shows 

the handholds along the perimeter of the platform. 

 The ground surfacing in the play areas at Coolidge Playground are Fibar. Fibar is 

considered ADA compliant when installed and maintained properly. It is an engineered 

wood fiber that is 100 percent ADA compliant and it 

is frequently used by parks departments in place of 

traditional wood chips (http://www.fibar.com). 

According to the company’s website, it must be 

installed to a depth of 8 or 12 inches (Fibar 

Systems, 2006).  Figure 13 shows that the Fibar in 

Coolidge Playground has a depth of about 8 inches. The 

proper rubber matting is also installed at all of the high-use 

zones, namely underneath the swings and at the bottoms of 

the slides. Some settling and displacement of the Fibar has 

occurred due to frequency of use. The manufacturer notes 

that it must be raked and redistributed when this occurs; it 

also may be necessary to add more Fibar, depending on how much settling has occurred 

(Fibar Systems, 2006). There has been a slight amount of settling in the toddler play area 

Figure 13 - Fibar Depth 

Figure 14 - Fibar Settling
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of Coolidge, which could make the area inaccessible. Figure 14 shows the amount of 

settling around the border of the playground, as well as the resulting lip. 

The Americans with Disabilities Act – Grievance Procedures 

 The grievance procedure is very important in towns like Brookline. Grievance 

procedure is important because, although some work is done while a park is being 

redesigned to make it ADA compliant, most of the time ADA compliancy does not 

become an issue until a grievance is received. In addition to making the parks more 

compliant we would also like to see the grievance procedure more efficient and effective. 

 The current process is explained on the official “Town of Brookline – The 

American’s with Disabilities Act – Grievance Procedure” form. The grievance process 

begins with a person completing the form and submitting it to the town ADA 

Coordinator.  The form states that “[t]his complaint should be submitted by the 

complainant or his/her designee as soon as possible, but no later than thirty (30) days 

after the alleged violation”. This established time limit varies some from other towns that 

were also examined. Newton for example puts no time limit on their ADA complaint 

form. Cambridge states on their website that “[a]ll complaints of discrimination must be 

filed within six months of the occurrence of the last act of discrimination.”   These time 

limits vary drastically thus it is necessary to be investigated further. For example the limit 

of thirty days imposed by Brookline may not allow enough time for someone to consult 

an attorney before they file the complaint. This could be both beneficial and detrimental 

to a town or city. On the one hand, if a citizen had time to consult an attorney before 

filing the complaint then they may be able to find out that they do not have basis for their 

complaint. This in turn would save the town or city valuable time and money. On the 
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other hand, a more lenient time limit could be harder for a town or city to deal with, for 

just like any investigation, facts become harder to find the longer they remain dormant.  

     Although the time frame is important, we do not feel that it is a serious problem. The 

form continues to explain the process by saying within five (5) calendar days of the 

receipt of the complaint the ADA Coordinator will forward the complaint onto a 

Conciliator. If the complaint is in regards to an employment policy or practice then the 

complaint will be passed onto the appropriate personnel director. If the complaint is in 

regards to non-employment benefits provided by the Town of Brookline the complaint 

will be forwarded to the appropriate Department Head. Within thirty days the Conciliator 

will meet with the complainant to discuss the complaint and possible resolutions. The 

complainant will then be forwarded a formal response in writing. The Town of Brookline 

also outlines an appeal process on this same form. The form itself is short and does not 

initially collect much information. Although the form is short it does an excellent job of 

explaining the procedure to the complainant. We found that the other communities do not 

lay out the procedure as well on their forms. In comparison to Newton’s grievance form 

Brookline’s could go much further to initially collect information. Brookline’s form asks 

for a name, address, telephone and a brief description of the complaint. Although this 

could be sufficient in some circumstances, it is always useful to collect as much 

information as possible. Newton’s form attempts to collect more information in terms of 

what the complainant intends to do or already has done. This form asks questions such as 

“Have efforts been made to resolve this complaint through any other means?” and “Has 

the complaint been filed with the any Federal, State, or local civil rights agency or 

court?” These are two important questions that should be asked initially. Having the 
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answer to these questions could save time and money. It would be useful to know if there 

have been previous attempts to resolve this issue and also what the outcomes of those 

attempt where so as to not repeat past efforts. Also, knowing if the person has filed with a 

state or federal agency could raise a red flag to the town or city as to how serious this 

issue may be.  
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CONCLUSIONS AND RECOMMENDATIONS 

We believe that the town of Brookline should be using a more proactive approach 

to comply with the ADA rather than the passive approach that is currently being used. 

We have reviewed the different ways that the City of Boston, Cambridge, and Newton 

deal with ADA compliance, identified several ADA compliance issues within Brookline's 

parks, and determined our recommendations based on how other towns and cities have 

dealt with these issues, as well as from a cost-benefit analysis.  

This study was completed in Brookline. While the government structure and 

available funds may vary from Brookline's, the recommendations for ADA compliancy 

and open space management can be applied universally. Based on the experiences and 

information that we have gained over the course of our project we see certain areas that 

are done well within Brookline and other areas that can be improved. We have 

established the framework of the park inventory database but the work will need to be 

continued. With limited time, we completed the inventory and GIS maps of the elements 

of twelve of Brookline’s parks. The data for the smaller parks of Brookline is complete 

and the setup work of the system is done. Brookline will need to continue our work and 

maintain the information in order for the system to be used to its fullest potential. After 

changes have been made to a park, the employees that worked on that park should make 

these changes in the database and reflect these changes on the GIS maps. To help with 

this process, we have developed a manual to help with instructions on how to do this. 

 Once complete, the database and GIS maps have potential to be used in many 

facets of the town government. One specific use of this tool would be to easily determine 

compliancy issues for certain features of the parks. For example, with the walkways and 
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benches visualized on the map, Parks and Open Spaces would be able to determine if the 

correct number of accessible benches is on accessible routes within the parks. Having 

features like electrical boxes, manholes, and plumbing access placed on the map will be 

useful for those particular departments when performing maintenance and renovations. 

The use of this system is not limited to the Parks and Open Spaces. Access to the 

system could be expanded to the general public. Putting these maps online will allow 

anyone to determine what the park in their neighborhood has or where they would have 

to go to enjoy an accessible visit. The possibilities are endless and will be left up to the 

user to determine the actual uses. 

Proactive Approach to ADA compliancy 

Our recommendation is to create a more proactive approach to comply with the 

ADA; this would save the town of Brookline valuable time and money that could be 

spent elsewhere in its parks system. With the current passive approach, problems with 

compliance are not dealt with until a formal complaint has been filed or a park comes 

under redevelopment. A formal complaint might only arise once a person is injured, and 

could put the town in legal trouble. Also, with a formal complaint that has been filed, 

Brookline is often inclined to bring in an outside consulting company.  

Outside consulting companies cost the community time and money. By taking a 

proactive approach, all the parks can be evaluated by the staff at the open spaces division 

of Brookline, to continuously examine ADA issues. Although the town of Brookline 

might have to spend money to fix the problems initially, it will save them time and 

money in the future since fewer complaints will be filed and the chance of a law suit due 

to an injury will be lessened. An approach could be as simple as educating the employees 
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who visit the parks daily about certain key aspects of ADA compliancy. Our idea is that 

the more people aware of ADA, the better the chance of identifying issues before they 

become a problem. 

Community Surveys 

 Completing user satisfaction surveys on a regular basis would allow the parks 

department to become more familiar with their customers. Fort Worth, Texas Department 

of Parks and Community services began their user satisfaction surveys when the state 

decided that they would not fund any master plan development without a needs 

assessment. The survey included a random sample of people that used the parks and 

people that didn’t use the parks. Within this random sample five hundred teenagers were 

included. This small sample is then extrapolated for the full population. Some 

information that was gathered from these surveys included a user rating of the parks, 

open spaces, and recreational programs. In addition to these questions users were asked 

what they would like to see in the parks as well as if they brought out-of-town visitors to 

these parks. Statistical information such as usage of the parks, time spent in the parks, 

what time of day, and what day of the week these visits were.  

 These surveys were completed by a third party and provide both positive and 

negative feedback. Fort Worth has found that these surveys to be useful when presenting 

information to city officials. A third party voice often is viewed as less bias. These 

surveys cost about $30,000 initially and then about $15,000 for following surveys. This is 

a small price to pay for the valuable information collected. (TPL, 2003) 
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Collaboration with Boundless Playgrounds 

 
 After inventorying the components of twelve parks, we realized that most of the 

playgrounds are not compliant with the guidelines—even the most recently renovated 

parks. Becoming compliant with the ADA is an important first step, but we believe that 

this is not enough. The guidelines only go so far as to make sure that all children—

disabled or not—have something to utilize in a playground. The guidelines do not require 

that all components of a playground are accessible, only a certain percentage. 

Furthermore, the guidelines are primarily focused on people in wheelchairs. There are 

many more disabilities, such as blindness and sensory disabilities, which should be taken 

into consideration when designing playgrounds. 

 Following the guidelines, elevated components are considered to be accessible if 

there is a transfer station. It can be embarrassing for children to have to abandon their 

equipment in order to reach the higher points of a structure. All children should be able to 

reach these points without struggling or facing humility. Brookline should continue their 

efforts to reach a fully accessible park system. 

Working with Boundless Playgrounds 

 The Boundless Playgrounds website (http://www.boundlessplaygrounds.com) 

contains a wealth of information. One can find information about budget considerations, 

ways to get started, forming committees and various subcommittees, as well as where to 

find more information. A comprehensive checklist is available which lists everything that 

is present in a Boundless Playground. There is also a list of ten steps to take in order to 

develop a new playground. 
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Apart from the free information and services, Boundless Playgrounds also offers 

fee-based services and training programs. The services offered include a design review 

service for existing playgrounds, mentoring services, which offer training, and custom 

configuration services, which will be helpful in designing a one-of-a-kind layout. The 

training is segmented into different levels, from beginner to advanced, and will help to 

ensure that all involved in the design process of new playgrounds will have the 

knowledge to create barrier-free playgrounds that are accessible by everyone. 

Communication with the Public 

 Communication with the public is something we found to be very strong among 

most of the communities that we investigated. A master plan, annual reports summarizing 

the system, and monthly newsletters were some of the many ways these communities 

communicated with the public. Every municipality should adopt these practices for it 

informs the community of the many facilities and services that the park system has to 

offer. This does not happen in more than half of the large cities across the United States 

(Harnik, 2003). Communication with the public can lead to broader community 

involvement as well as increased usage. 

BMC® Remedy® Change Management 

 During our investigation of the Cambridge Human Services Department we found 

a software solution that manages issues and complaints within their government. This 

software solution allows the town officials to easily file a complaint. This system is 

essentially a work order management system. This management system is integrated with 
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their GIS in that it allows the user to choose the road and the nearest intersection of the 

problem.  

 We have spoken with the Program Manager, Scott Hamilton, about the work that 

went into implementing this software. BMC offered the base line software and then it 

was highly customized by GE IT Solutions. The total package cost around $350,000 with 

the BMC software costing around $250,000 and then the customization from GE costing 

around $80-90,000. Our main focus was on the reporting of the ADA issues within the 

system but this system is intended for the whole government. This system can be used to 

track labor costs as well as vehicle costs. This system also aids in overall consistency. For 

example, someone might enter “Mass Ave.” where as someone else might enter 

“Massachusetts Ave.”.  The specific software that Cambridge uses is "BMC® Remedy® 

Change Management” and “BMC® Remedy® Asset Management”. This particular 

software may not be the right one for Brookline but similar software solutions exist.  

These types of software solutions should be investigated further.  

Complaint Form 

 Our recommendation is that Brookline and other towns begin to take steps to 

handle ADA grievances more effectively by expanding the communication lines between 

the citizens and the city or town. By utilizing the Internet and also having the ADA 

complaint form available at other town offices this can be achieved. We would like to see 

governments allow for more feedback rather than strictly grievances. If citizens can 

provide formal and informal feedback to the town or city then many issues can be 

resolved before they become serious.   
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In order to formally complain about an ADA compliancy issue, it is necessary to 

complete Brookline’s complaint form and submit it to the ADA Coordinator.  The 

problem lies in the location of these forms. Currently, if a citizen wishes to file a 

complaint it would require a trip to the ADA Coordinator’s office and retrieve the form. 

It would be favorable if the form were readily available and located on Brookline’s 

website (http://www.townofbrooklinemass.com).  This would provide the town’s citizens 

with access to the form at their convenience.  Having the form readily available is 

imperative to a timely response to the issue at hand due to the thirty day limit that is in 

place.  The form could also be expanded to be a form that a citizen could fill out on the 

website and electronically submit the grievance. If a feedback channel for issues within 

the parks were opened then the municipalities would receive more comments and 

recommendations. The more accessible it is for someone to file a complaint the better the 

chance of the city or town to be able to rectify the issue at the local level without having 

to escalate the problem to the state or federal level. 

Web Content Accessibility Guidelines 

Not only do we recommend that this form be online, the Web site will need to conform to 

the World Wide Web Consortium’s (W3C) Web Content Accessibility Guidelines 

(WCAG). The WCAG provide techniques for making sites more accessible. A total of 14 

guidelines help to ensure that everyone can access the site. There are different types of 

disabilities that affect the way a person interacts with a site. Colors have to be chosen 

carefully to assure that people with colorblindness will be able to read the text. The 

layout must be chosen wisely so that screen readers will be able to interpret and read the 

page correctly. People with cognitive disabilities may have trouble with animations or 
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moving objects; these should be kept to a minimum. Using these guidelines will help to 

make the form as accessible and available as possible. 

 In summary we believe that the implementation of our recommendations would 

greatly improve ADA compliancy within Brookline's parks. In addition to improving 

ADA compliancy they will also improve park management. Since a vibrant park system 

can benefit a community in so many ways, improving the system should be a high 

priority for any municipality.  
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APPENDIX A 

Project Sponsor Contact Information 

Tom Brady 
Brookline Parks & Recreation Department 
E-mail: tom_brady@town.brookline.ma.us 
Cell phone: (617) 201-5514 
 

Parks and Open Space Division – Mission Statement 

http://www.town.brookline.ma.us/recreation/ 

 To develop a safe accessible well maintained network of parks and open spaces 

for both passive and active recreational uses the preserves the historic integrity and 

cultural significance of Brookline’s landscape. 

Parks and Open Space Division – Goals and Objectives 

 The purpose of the Parks, Recreation and Open Space Master Plan is to guide 

recreation, parks and open space amenities, services, programs and facilities within the 

Town of Brookline for the next ten years.  The Master plan established a policy 

framework for parks, opens spaces, and recreation; management and maintenance 

program recommendations; and capital improvement plan.  The strategic objective of this 

document requires that the entire Town-owned parks, open space, and recreation system 

be evaluated on a Town-wide level.  The scope of this Plan is far-reaching, ranging from 

sports to community programs, parks to community center, as well as municipal user 

fees.  The recommendation of the Master Plan for Parks, Open Space and Recreation are 
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designed to meet the mission and goals of the Recreation Department and Parks and 

Open Space Division. 

Work Completed So Far 

 The previous work done by the Parks Department is limited at best. Parks data 

was collected several years ago and is outdate. The general information about the parks is 

fairly complete. The information becomes inadequate when the condition of the 

equipment is considered. For example, the equipment inventoried several years ago is 

either removed or the condition has changed. In addition to this, the location of the park 

assets has yet to be determined.  

 Organizational Chart 
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APPENDIX B 

MANUAL 

INTRODUCTION 

 What this manual is: This manual is intended to be used by those who will be 

continuing our efforts in creating GIS maps of the parks of Brookline. It describes the 

process of inventorying the components of a park. It then outlines the process of creating 

a new map, including the necessary layers, what icons and colors to use, and how theses 

layers should be ordered on the map. The process of joining tables in the database with 

tables from the map is also described. 

 What this manual isn’t: This manual will not teach the basics of the ArcGIS 

suite, nor will it describe the process of using Microsoft Access. 

HOW TO INVENTORY 

Start off by printing a blank map of the area. This can be done by printing the 

aerial photo from the Access database, or by finding the park in ArcMap. Usually the 

ArcMap photos are of a higher quality and are preferred. We have found that printing two 

copies is best. One copy can be used for all of the equipment, and one can be used for 

outlining walkways, stairs, curbing, and ramps. 

What should be included 

Here is a partial list of what should be included in the inventory. To become more 

familiar with all of the data, we suggest that you browse the database. 
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• Access points 
• Trash barrels 
• Play structures 
• Benches and sitting walls 
• Picnic tables 
• Walkways 
• Utilities (electric boxes, lighting, meters, water fountains) 
• Drains (catch basins and sewers) 
• Fences 
• Memorials 
• Signage 
• Recreation buildings 
• Athletic fields 

 

Required attributes 

Every element has required attributes that must be recorded. For all elements, the 

location, condition, and accessibility are required. 

Access points • Type (pedestrian or maintenance) 
Trash barrels • Type (fixed metal or portable plastic) 

• Manufacturer 
Play structures • Type (swing set, climbing structure, spring toy, 

sandbox) 
• Manufacturer 
• Ground surfacing 
• Age group (infant, toddler, child) 
• Climbing structure components: 

o Slides, play panels, monkey bars, tracks, etc. 
Benches and sitting walls • Type (wood, metal, plastic, cement) 

• Base (cement, pavement) 
• Manufacturer 
• Angle (which way the bench is facing) 

Picnic tables • Type (wood, metal, plastic, cement) 
• Base (cement, pavement) 
• Manufacturer 

Walkways • Type (dirt, gravel, pavement, cement) 
Utilities • Type (electric boxes, lighting, meters, water fountains, 

storage, recreation facility) 
• Manufacturer 

Drains • Type (catch basins and sewers) 
• Notation (“Sewer”, “Br W W”) 
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Fences • Type (cast iron, vinyl-coated chain-link, chain-link, 
decorative metal) 

• Height 
Memorials • Type (sign, granite) 

• Message 
Signage • Type (interpretive, rules and regulations) 

• Message 
Athletic Fields • Type (baseball, basketball, open space, tennis court, 

football, soccer) 

How to record the data 

Along with the printed maps, a field book is required. The easiest way we have 

found to record the data is to number each item. On the map, each element will have its 

own number. In the field book, the number is written down along with what the number 

refers to and all of its attributes. Similar items can have the same number. For instance, if 

there are several fixed metal trash barrels—all of the same type—they can share one 

number. For curbing, stairs, and walkways, we find it easiest to draw the element on the 

map and write its attributes next to it. The number system can also be used here. This is 

just one way of doing it that has worked well for us, but there is always more than one 

way to do it. 

Editing the Access Database 

The database is located on the network drive \\tfile001\conservation\GIS 

Projects\ParkInventory\Parks Database.mdb. When opening the database, you are 

presented with the main form. 

All of the data can be entered 

through this form, but it is more practical to 

edit the tables directly, as this will allow you 
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to see the IDs of the items you are entering. Each element is required to have its own ID. 

The parks that have not yet been updated will need to be corrected. For instance, each 

bench needs to be entered as one item. Currently, all of the benches are grouped together 

as one entry. If a park has ten (10) benches, there must be ten entries in the database. This 

is required for every type of element. The locations are also important, as the location 

entered into the database must match the location of the item on the GIS map. 

Entering the Information into ArcCatalog 

Creating a map 

Outline: 

• Create a new Feature Dataset in ArcCatalog 
• Create the necessary layers 
• Create a new map from template in ArcMap 
• Insert the layers created in ArcCatalog 
• Add all of the elements, inputting the IDs corresponding to the database 
• Add the tables from the database to create joins 
• Create joins for the necessary layers 
• Group the layers 
• Create a printable version of the map 

ArcCatalog 

The database for the GIS maps is located in \\tfile001\conservation\GIS 

Projects\ParkInventory. The database is called ParkInv.mdb (note: this is a separate 

database from the parks database. The parks database is called Parks Database.mdb). 

Each layer of the GIS map must have it’s own table in the database. These tables are 

called Feature Classes. The layers are grouped in what ArcCatalog calls a Feature 

Dataset. For each park there is one feature dataset containing multiple classes. 
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Creating a new Feature Dataset 

1. Right-click on ParkInv.mdb and click New->Feature Dataset. Give it a name of 

TestMap 

 

2. Click Edit to define the spatial reference. You should now have a new window titled 

“Spatial Reference Properties.”  

a. Under the Coordinate System tab, click the select button. 

b. Now double-click Projected Coordinate Systems, State Plane, NAD 1983 

(Feet), and finally NAD 1983 StatePlane Massachusetts Mainland FIPS 2001 

(Feet).prj. 

c. Next, click on the X/Y Domain tab. Change Min X to -10000000, Min Y to -

8000000, and Precision to 100. 

d. Click the OK button in this window, followed by the OK button in the New 

Feature Dataset window. 
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You are now ready to start adding layers. 

Adding layers 

1. To add a new layer, right-click on the newly created dataset (TestMap) and click 

New->Feature Class. For this example, you will add two layers, one for furniture, and 

one for utilities. 

2. In the New Feature Class window, enter the name Furniture_TEST1; then click Next. 

3. The defaults in the next window are fine; click Next again. 

4. Here you need to add three fields: ParkID, FurnitureID, and Angle2. ParkID and 

FurnitureID are both of type Long Integer and Angle is of type Double. 

5. Click on the SHAPE field and change the Geometry Type to Point3. Now click 

Finish. 

                                                 
1  The _TEST ending is necessary in order to differentiate between the furniture layers in each park. 
The naming convention we use is the first four letters of the park, and will be required as a suffix for each 
layer created. 
2  The furniture layer is the only layer which requires the Angle field. This field will be used to 
rotate the benches so that they face the proper direction. 
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6. Repeat steps1 – 5 for each layer required. Remember that only the furniture layer 

requires the Angle field.  

 

ArcMap 

Starting a new map 

When opening ArcMap, you will first be presented with a dialog. In this dialog, 

select Start using ArcMap with A template, then click OK. In the next dialog, click the 

browse button  in the lower right corner. Select ParkTemplate.mxt (this should be the 

only template available) and click Open.  
                                                                                                                                                 
3  The Geometry Type is not always going to be Point. For instance, the Athletics Fields layer uses 
the Polygon Geometry Type. Please refer to the document which describes all of the layers. 
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Now you need to find the location of the park. To do this you will use the find 

dialog. Click Edit->Find. For this example, you will add items to Linden Park. In the 

Find text box, enter linden, then click Find. Two objects will be found. Right-click 

Linden Park and click Zoom to feature(s). This will focus the map on Linden Park. Now 

close the find dialog. Your screen should look similar to the screenshot below. 

 

Next click File->Save As to save the map. You will save the example as testmap. 

Type “testmap” into the File name text box, then click Save. 

Now you are ready to add the layers to the map. 
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Adding Layers 

To add the two layers that you created in ArcCatalog, click File->Add Data. 

Navigate to the ParkInv.mdb database, double-click TestMap, then highlight the two 

layers and click Add. 

Start Editing 

1. To start adding the data to the map, click the Editor button  on the Editor 

toolbar, then click Start Editing. 

a. If the toolbar is not visible, click View->Toolbars->Editor. 

2. In the dialog, choose ParkInv.mdb; then click OK. 

3. On the Editor toolbar, make sure the target is set to Furniture_TEST. 

 

You can now insert all of the furniture. 

Inserting the furniture 

You will now add the six benches around the sandbox, the four around the tree, the 

three picnic tables, and the two trash barrels. Their IDs are already in the database, so you 

will use those IDs. 

1. Click the Sketch Tool button  on the Editor toolbar. 

2. Insert the first one on the northern side of the sandbox; then click the Attributes 

button. 

3. Enter the ParkID, which is 14, and the ID of a bench located around the sandbox. 

There are six of them in the database, the first one starting at 264. 
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4. Leave the angle alone for now; you will get back to this later. 

5. Add the remaining furniture, entering the appropriate IDs for each item. 

a. Insert the other nine benches. 

b. Insert the three picnic tables. There are two at the tree on the right, one to the 

left of the sandbox. 

c. Insert the two trash barrels. There is one at each entrance. 

When you are done you should have something which looks like the following screenshot 

(Note: the color and size of the icon has been changed to make it easier to see them in the 

screenshot). 

 

Save your edits by clicking Editor button, then Save Edits. Then click Stop Editing in the 

same menu. 

Joining tables 

Having all of the furniture on the map is nice, but kind of useless when the 

different types share the same icon. To fix this, you need to add some tables to ArcMap 

and perform some joins on these tables. 
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The type of furniture (table, bench, trash) is actually an ID number. There is a 

lookup table which specifies what each of these numbers stands for. The lookup table is 

in the Parks Database, as well as the data table. Because of this, you need the lookup 

table and the data table. For furniture, you must add lkpFurnitureTypes and 

tblFTRFurniture. To do this, click the Source tab on the bottom left of ArcMap, then 

click File->Add Data. Navigate to Parks Database.mdb; then add lkpFurnitureTypes. 

Repeat the process for tblFTRFurniture. 

Joining the tables 

 First you need to join the lookup table with the data table so that the furniture 

types will be displayed, instead of the ID numbers. 

1. Right-click on tblFTRFurniture, then 

click Joins and Relates->Join. 

2. In the dialog: For part 1 choose 

FurnitureTypeID; for part 2 choose 

lkpFurnitureTypes; for part 3 choose 

FurnitureTypeID. Then click OK. 

3. Switch back to the display tab. 

4. Right-click on the Furniture_TEST 

layer, then click Joins and Relates-

>Join. 
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5. For part 1 choose FurnitureID; for part 2 choose tblFTRFurniture_lkpFurnitureTypes 

(this is the joined table you just created); for part 3 choose 

tblFTRFurniture.FurnitureID. Then click OK. 

These steps enable us to distinguish between the different types of furniture, which will 

allow us to give them different icons. 

1. To do this, right-click on the Furniture_TEST layer, then click Properties. 

2. In the Layer Properties dialog, click the Symbology tab. 

3. To the left there is a list box labeled “Show”. Click Categories, and under this click 

Unique values. 

4. There is a box labeled Value Field. In here choose the last item, which will be 

lkpFurnitureTypes.Name.  

5. Click the Add All Values button.  

You should now have a dialog that looks like the one below. You can see that there are 

10 benches, 3 picnic tables, and 2 fixed trash barrels. This is correct, and a good way to 

check that you are doing things correctly. Uncheck the <all other values> check box. 

Click OK. 
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Now each type of furniture has its own icon. It would be nice if the individual 

types could be hidden and shown separately, but this is not possible with the current 

setup. The solution you are using for this is simple. 

1. First, right-click on Layers at the top of the Display pane, then click New Group 

Layer. 

2. Right-click on the new item, then click Properties. 

3. In the dialog, change the layer name to Furniture, then click OK. 

4. Drag the Furniture_TEST layer into this group layer. 

5. Next, right-click on this layer and click Copy; then right-click on the Furniture group 

layer and click paste. Do this twice. 

Steps 6 – 8 describe the process of changing each layer’s symbol. The bench layer is the 

only layer that requires a font. The rest of the icons are in the built-in lists, and can be 

found in the appendix at the end of the manual. 

6. For each layer: 

a. Go to layer properties, then the Symbology tab. 

b. If it is not already showing the categories, click Categories. 

c. Click on Picnic Tables, then Remove. Do the same for Trash Fixed. 

d. Now double-click the icon next to Benches. Click the Properties button.  

e. In the Type field, choose Character Marker Symbol. 

f. Change the font to ESRI US MUTCD 2. 

g. Change the Unicode number to 196, set the size to 11, the angle to 90, and the 

color to Medium Apple. 

h. Click the OK button on all three dialogs. 
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i. Now change the layer name to Benches. 

7. Repeat the same process for the next layer, leaving all but Picnic Tables in the list. 

a. Double-click on the icon. 

b. Under More Symbols, click Civic. 

c. Choose the Picnic Area 2 icon. Click OK on the two dialogs. 

d. Change the layer name to Picnic Tables. 

8. Finally, for the last layer, leave everything but Trash Fixed in the list. 

a. Double-click its icon. 

b. Under More Symbols, choose Forestry. 

c. Under Category, choose Facilities. 

d. Choose the first icon, which is Drinking 

Water. 

e. Change the color to Black, and the size 

to 13. 

f. Click OK on both dialogs. 

g. Change the layer name to Trash Fixed. 

Rotating the benches 

The final step with the furniture layer is to rotate the benches. First you need to 

tell ArcMap which field to use for rotation. 

1. Right-click the benches layer and click Properties. 

2. Switch to the Symbology tab. Click Categories. 

3. Click benches (this should be the only item in the list). 
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4. Click the advanced button, then click Rotation. 

5. Change the item in the box from <None> to 

Furniture_TEST.Angle. 

6. Click OK on both dialogs. 

And now to change the angles: 

1. Start editing again, choosing the ParkInv.mdb 

database. 

2. For each bench, click on it, then click the attributes button. 

3. Let’s start with the first bench you added. The benches around the sandbox face the 

sandbox, so that is what you will rotate it to do. An angle of 150 seems best for this 

bench. Enter 150 into the angle field. 

4. Repeat steps 2 and 3 for each bench, choosing the angle that looks best. 

Tip: Negative angles can be used. 

Your map should look similar to the following. 

 

Stop editing and save your edits. 
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The same steps are required for the utilities layer. This includes adding the joins 

and creating the group layer. However, nothing else needs to be rotated. The table names 

and icons will be different, but the process is the same. 

All layers are required to be joined to the corresponding tables to provide the link 

to the database. However, only the furniture, utilities, and sitecontrol2 layers must be put 

into group layers with separate icons. 

Creating a printable map 

The data view is great for seeing the data, but not so great for printing a map. The 

layout view is more suitable for this, providing tools allowing for titles, scales, legends, 

and north arrows, among other things. 

Setting up the layout 

1. To switch to the layout view, click View->Layout. 

2. Linden Park has more of a horizontal shape, so a landscape layout is best. Click File-

>Page and Print Setup. In this dialog, change the size to 11x17 and the orientation to 

landscape. Click OK. 

3. Resize the map portion to take up most of the space, leaving a small margin at the top 

and bottom for the title and scale, and a larger margin on the right for the legend and 

north arrow. 

4. Insert a title by clicking Insert->Title. Change the text to Test Map, then center it at 

the top of the page. 

5. Click Insert->North Arrow to select a north arrow. We have chosen ESRI North 7. 

Select this and click OK. Move the arrow to the top-right corner and resize it as you 

see fit. 
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6. Click Insert->Legend to insert a legend. 

a. In the legend wizard, remove OpenSpace and Mosaic.sid. You don’t need 

these in the legend. Click Next. 

b. Under Title Justification, choose to center the title, then click Next. 

c. For the border choose 0.5 Point, and give it a Grey 10% background. Then 

click Next twice, and finally finish. 

d. Right-click on the legend, then click Properties. In the Legend Items list select 

all of the items, then click Style. Choose the third choice (Horizontal Single 

Symbol Label Only), then click OK. 

e. Using the vertical arrows, reorder the items in the legend so that they are in 

ascending alphabetical order. Click OK. 

f. Move the legend into the right margin, resizing either the map or the legend so 

that they fit nicely. The legend is dynamic, so any layer names or icons that 

you change will also change in the legend. 

7. Finally you insert the scale by clicking Insert->Scale Bar. Choose the first one, then 

click OK. Resize the scale bar, then center it at the bottom of the page. 

You should now have a layout that looks like the following. 
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Depending on the particular map, a portrait view may be used, but the steps are still the 

same. 
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APPENDIX C 

Interview with Beverly Droz 

Newton Director of Human Services & ADA Coordinator  
 

 
Monday, April 10, 2006 

History 

• Newton has  Mayor’s Commission for People with Disabilities 

o Commission has been active for 30 years and meet monthly 

• Issues the Commission handles 

o Planning and development program and funding 

o Community Access- What needs to be fixed? 

 Elements that the city knows what and when to fix because they 

are “city owned” 

 Curb cuts, sidewalks, pedestrian crossings, signals etc. 

• Citizen Issues 

o Call-ins from handicapped people 

 Recommendations and complaints as to what needs to be fixed 

Complaint Forms 

• Newton presently has multiple forms that can be accessed on the internet 

(www.ci.newton.ma.us)  

Process 

• When Beverly receives a complaint: 

1. It is tracked within her office 
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2. She consults her co-worker from the Planning and Developing Department 

3. General complaints are also handled by their Inspectional Services Liaison 

Lowell Haynes (ramps to stores, walkways etc.) 

4. Once the investigation is considered, Beverly handles the resolution and 

informs the concerned citizen that their complaint is in process 

5. Beverly then filters the problem and proposed resolution to the appropriate 

department 

Parks and Recreation Department 

• Evaluations of how parks can be more accessible 

• Example of safe and accessible park in Newton: Albermarle Playground  

• There is not a set time frame as to how often parks are renovated 

• Example of park that needs to be renovated: Playground located adjacent to 

Mason Rice Elementary School 

• Major Park in Newton: Cold Springs 

• During the months of July through October, Newton holds an open air market that 

is completely accessible 

• Parks and Recreation Department works closely with Mayor’s Commission of 

People with Disabilities and addresses their “To Do” list 

• Normally, they are on top of what needs to be fixed 

Law Department 

• Newton has a great resource in their law department to refer to 

• When there are legal issues in question, they can always consult with their legal 

department 
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Board of Aldermen 

• Comprised of 24 members 

• Biggest in Massachusetts 
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APPENDIX D 

Interview with Michael J. Muehe 

Cambridge Executive Director Commission for Persons with Disabilities/ADA 

Coordinator 

Tuesday, April 18, 2006 

Commission for Persons with Disabilities  

• Comprised of staff members and volunteer citizens 

• Meet on a monthly basis 

• Duties 

o General reference for disabled citizens regarding issues such as parking 

requirements, transportation etc. 

o Work in conjunction with Cambridge City Government to ensure all city 

programs are accessible 

o Consultants for private sectors such as: training sessions and technical 

assistance 

Programs 

• Facade Improvement Program (Community Development Program) 

o Example: If a business spends up to $35,000 on their store front, the 

Façade Improvement Program will match that as long as the store front is 

now ADA accessible 

• Accessible Taxi Cabs 

o Cambridge has seven mini-van type accessible taxi cabs 

 73



o Implemented this program due to the costly expenses of “Private Chair 

Cars” 

• Inter-department Open Space Committee 

o Attendees 

 Department of Public Works 

 Water Department 

 Community Development Department 

 Commission for Persons with Disabilities 

o Address various issues 

 Park accessibility 

 Curbing 

 Ramps 

Complaints 

• Forms 

o Reasonable Accessibility 

o Grievance 

Process 

• Very few complaints come intro Michael 

o Typically the same people 

• Case by case approach 

• Sent out to appropriate department 
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Cambridge Request System 

• Computer-based form 

• Linked to Cambridge’s GIS System 

• Process 

o Indicate specific complaint and its location 

o System will e-mail which staff member that is responsible 

o Progress will be tracked 

o Regular reminders will be sent to staff member until problem is resolved 

After the interview was completed, Ryan and Katie visited a local park with Michael 

called Reginald Wilder Playground.  Topics specific to that particular playground were 

discussed. 
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APPENDIX E 

Interview with Professor Malcolm FitzPatrick 

Civil & Environmental Engineering Department 

1. Have you ever used GIS and if so, how would you describe its uses? 

A:  Well have you heard of Earth Google?  Basically, GIS’s functions depends on its 

use.  It makes “data layers.”  For example, you can have street layers, tree layers, 

house layers.  You can layer them all at once or perhaps you could just have trees and 

houses displayed.  On a more advanced level, you could have street conditions and 

layer it by good street conditions, fair street conditions, and poor street conditions.  

Have you seen Fabio Carerra’s Thesis?  It deals with that sort of thing.  The GIS 

System can help tremendously with design. 

 

2. In your opinion, what is a parks’ role in urban planning? 

A:  Their uses entail protecting natural garments such as trees and waterways.  They 

serve as a respite from an urban environment where people can get exercise, go for a 

picnic etc.  The parks serve as linkages for people to travel from one place to another. 

 When a city or environment has many parks, a much higher density is allowed 

which can also lead to mass transportation. 

 

3. We’ve been looking a lot into the demographics of Brookline, what affect does 

demographics have on the parks? 

A:  The only conflicts that I could see arising with parks in conflicts of usage.  For 

example, rollerbladers vs. mothers with baby carriages.  I think it’s every town and 
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city’s intention to be able to include the entire community but sometimes that is not 

always possible. 

 When I think of parks I think of a various amount of things such as large open 

spaces to neighborhood parks that include not only “neighborhood” use but regional 

use.  Parks should be somewhere where both young and older people can mingle 

among each other.   

 You know, some studies have even shown that in some areas land right next to 

parks decrease in value due to acts of vandalism etc.  Despite that study in general, a 

park improves the overall value of a neighborhood as long as it’s far enough away 

from the park itself. 

 

4. What characteristics does a park need to be great? 

A:  The parks’ safety, maintenance, esthetics, and what specifically the park is known 

for.  Like the park in the North End that people always play chess and bocce ball in.  

Also, it always helps the atmosphere of a park when there are snack or concession 

stands or something of that variety. 

 

5. Do you have any reference recommendations for us? 

A:  The Journal of American Planning Association, Town and Country is a British 

Journal (Prof. wasn’t sure if that was the name), and Land and Recreation Society.   

 

6. Have you ever had to accommodate to the ADA and what have been your 

experiences with it? 
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A:  Yes I have and my only recommendation is to abide by it!  The ADA can get 

confusing because there’s so many different levels of it.  It’s good to get a landscape 

architect who knows the ins and outs of the ADA. 
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APPENDIX F 

Interview with Juanita Mincey 

Boston ADA Coordinator 
 

Wednesday, April 19, 2006 

History 

• ADA, Human Rights and Civil Rights are all one concept 

• ADA in parks is still a working process 

o Other issues need to be handled: employment, housing etc. 

• Accessibility is a necessity 

• Getting outside of your house is a necessity when one is handicapped 

• Accessible parks should be a place to reassure disabled persons that their 

disability is not all of them, only a part 

• Accessible parks 

o Meditate 

o Different frame of mind 

o Necessary for better health 

o Enables to change from one environment to another 

• Important Accessible Features 

o Water Fountains 

o Tables 

o Benches 

• Water Features are ideal 
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• Problems within accessible parks 

o Holes 

o Bricks 

o Bridges 

o Gravel 

o Grass 

• Access and Design 

o Difference within drawings and regulations and its implementation 

o Landings 

o “Learn by doing” process is what really works 

o Massachusetts one of the most stringent states in the U.S. for applying 

federal regulations 

 With this comes numerous pressures 

Complaints 

• Does not receive many complaints in relation to their parks 

• Numerous phone calls are parents and citizens inquiring as to where the 

accessible parks are 

• Anything built in the city of Boston has to approved by the ADA Department 

• It will not be built unless it has a “stamp of approval” 

• Historical sites in Boston try to “sneak by” some of the ADA regulations 

• Boston does not have a Disabled Person Commission 

• Boston does not have a complaint form for its citizens to complete 
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Process 

• Complaints are received by telephone, then computerized 

• Mayor does not believe in voice mail  

o Staff are to be available at all times 

o Should talk to a person, not a machine 

• Mayor’s 24 Hour Hotline 

• Mandatory to respond with 24 hours of a complaint 

• When complaints are anonymous, the response process does not need to be as 

timely 

• Citizens sometimes have unreasonable expectations 

• ADA Department never makes any promises, nor do they try to “sugar-coat” 

issues 

o Makes the process a lot easier 

Examples of Complexity of ADA Process 

• Chares River Park area are extremely particular 

• Parties involved in CRP construction 

o Commissioner  

o Community residents 

o Public meetings 

o BRA 

• Elevator needs to be installed in State House 

• Four Committees just for this issue 
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APPENDIX G 

Interview with Stephen Bressler 
Brookline ADA Coordinator  

 
 
Monday, April 3, 2006 
 

1. How many complaints are received per year? 

• I receive fewer than a handful complaints a year, but that doesn’t mean the 

other departments receive complaints.   

 

2. Who receives most of the complaints? 

• Sometimes the people contact the source directly, the town webmaster, 

Commission for the Disabled, walk-ins, phone calls to the state, 

Massachusetts Commission for Disabled or throughout the community. 

 

3. If a complaint were to come to town hall, would it ultimately be channeled to 

you? 

• It is channeled to the Department Head that would have to deal with the 

issue. 

 

4. How are they documented? 

• We file the complaint forms.  Sometimes cases become a “he said, she 

said” situation. 
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5. Are they public?  If so, where can they be accessed? 

• Yes, the complaint forms that are filled out are kept on file. 

 

6. Is the ADA Transition Team still active?  If so, how can they be reached? 

• Yes the team is ongoing.  The team meets periodically.  Topics such as: 

packed gravel, traffic lights, and pedestrian lights with audible signals 

(particularly on Beacon St.) 

Discussion 

• I meet periodically with the DPW among the several departments.  We try to 

accomplish a self-evaluation. 

• Complaints 

o After winter, around now, we receive a lot more complaints because of 

the effect of the weather on the outdoor equipment 

o Mobility problems with slopes of ramps and cracks in ramps 

o People with hand disabilities:  have problems with railings, gates 

rusting etc. 

• Construction 

o Sometimes when there are a lot of things wrong with the park, it might 

not be worth to fix because it is just going to be torn up and done again 

o Pounds of pressure needed to be put on gates is a problem for people 

with hand disability 

o Gravel and Fibar issues: some people like it, some people don’t 

• Halls Pond 
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o Competing interests 

o Can’t exactly black top a sanctuary so wheelchairs and crutches can 

use it 

o Parents want their children to have the full experience 

o Always complaints about “getting the full experience” 

o Try to make accessible as possible: DVDs, videos, internet etc. 

• Where Stephen Bressler fits in 

o Facilitate resolution of complaint  

o Cooperation among all parties involved 

o Every case is unique  

o Never an easy fix 

• Examples 

o School for brain-damaged teens 

 Wanted a path of travel which meant the walkway would have 

to be modified in a national historic area which was not 

feasible.   

 Blasting, a lot of money and altering the area’s character would 

be involved 
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PREFACE 

 
What this section is designed for is to help simplify Sections 16, Regulatory 

Negotiation Committee on Accessibility Guidelines for Outdoor Developed Areas.  It is 

not a section of regulation that pertains to ADA issues but the guidelines as stated by the 

ADA commission in 1999.  This entire appendix is a summary of Section 16, and none of 

it is written by the authors of this paper, except some examples pertaining to Brookline. 

Some sections from the original document have been omitted because they do not pertain 

to Brookline or most city areas. Sections related to campgrounds and campground related 

materials such as fix pitted toilets, fire rings, utility sinks, and rinsing showers have been 

excluded from this document. This document is referred to several times in the data and 

analysis chapter, which will help the reader to understand the ADA regulations. 

SECTION 16 

 Outdoor developed areas covered in this section shall comply with the applicable 

requirements of section 4 and the special applications sections, except as otherwise 

modified in this section. The following document is guidance to provide and assist 

designers and operators of these outdoor facilities  

SLOPE AND RISE 

Slope represents the proportion of vertical rise to horizontal length and can be 

represented as a ratio, percentage, pitch or in degrees. 

Rise:length percent pitch (tangent) degree 

1:8 12.50% 0.1250 7.13 
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1:10 10 0.1000 5.71 

1:12 8.33 0.0833 4.76 

1:13 7.69 0.0769 4.40 

1:14 7.14 0.0714 4.09 

1:15 6.67 0.0667 3.81 

1:16 6.25 0.0625 3.58 

1:17 5.88 0.0588 3.37 

1:18 5.55 0.0555 3.18 

1:19 5.26 0.0526 3.01 

1:20 5.00 0.0500 2.86 

1:50 2.00 0.0200 1.15 

 

16.1– GENERAL  

 All newly designed and constructed pedestrian trails, altered portions of existing 

pedestrian trails connecting to designated trailhead or accessible trails shall as well as all 

newly designed and constructed parks, playground equipments, facilities, and picnic 

areas shall comply with this section (Section 16). 

 Routine or periodic maintenance activities do not trigger the technical and 

scoping provisions of section 16. For example, if an entirely new bridge were installed to 

replace a step stone crossing, the bridge would be required to comply with the relevant 

provisions of Section 16. However, the trail on either side of the new bridge would not 

require modification. 

 

 As a general rule, alterations are performed to change the original purpose, intent, 

or design of a facility. Examples of actions that would be considered alterations include, 

but are not limited to: 
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1. Installation of a new trail tread surface, bridge, boardwalk, railing, safety 

barrier, signage, and/or puncheon(plank road) 

2. Construction, reconstruction, or installation of a new trail segment, new 

built features such as restrooms or picnic areas, bridges, gates, benches, 

safety barriers, and/or steps 

3. Removal of existing features 

4. Hardening of trail surfaces 

5. Rerouting or widening a significant portion of an existing trail 

 Maintenance and repair are performed to return a facility to the standards or 

conditions to which it was originally designed and built. This type of work is not an 

alteration because it does not change the original purpose, intent, or design of the facility. 

It is recognized that in outdoor environments, the ability to maintain the facility is usually 

much more limited than in the built environment. Except in highly developed areas, 

maintenance and repair occurs relatively infrequently. Examples of actions that would be 

considered maintenance and repair includes, but are not limited to: 

1. Removal of debris and vegetation such as downed trees or broken 

branches in the trailway, clearing the trail of encroaching brush or grasses, 

and/or removing rock slides 

2. Maintenance of the trail tread such as filling of ruts and entrenchments, 

reshaping the trail bed, repairing the trail surface and washouts, installing 

rip rap (rock placed to retain cut and fill slopes), and/or constructing 

retaining walls or cribbing to support the trail tread 
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3. Replacing or installing necessary drainage structures such as drainage 

dips, water bars, or culverts, and/or realigning sections of trail to deter 

erosion or avoid boggy/marshy areas; and 

4. Repair of trail and/or trailhead structures, including painting, removing 

graffiti, and/or replacement of deteriorated, damaged, or vandalized parts 

of structures such as sections of bridges, boardwalks, information kiosks, 

fencing, and/or railings. 

16.1.1 – Extent of Application 

 Departures from specific technical provisions of this section shall be permitted 

where specified, and where at least one of the following conditions is present.  You will 

see many EXCEPTIONS in this document that will refer to this section, but it is 

important to remember that the conditions in this section do not prevent or limit in any 

way obligations to comply with 16 at any point that the conditions are not present.   

16.1.1.1 - Cultural, Historic, Religious, or Significant Natural Features 

or Characteristic 

 Where compliance would cause substantial harm to cultural, historic, religious, or 

significant natural features or characteristics.  Examples of these conditions include: 

1. Areas protected under Federal, State, or local laws. 

2. Species designated as threatened or endangered. 

3. Designated wetlands that could be threatened or destroyed by full 

compliance with the technical provisions. 

4. Burial grounds and cemeteries. 
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5. Significant historical features may include properties on or eligible for the 

National Register of Historical Places or other places of recognized 

historic value.  

6. Significant religious features may include sites sacred to Native 

Americans and other properties designated or held sacred by an organized 

religious belief or church. 

7. Significant natural features may include a large rock outcrop or a unique 

water feature. 

16.1.1.2 – Alteration of the nature of the setting or the purpose of the 

facility, or portion of the facility 

 Where compliance would substantially alter the nature of the setting or the 

purpose of the facility, or portion of the facility. Examples of these conditions include: 

1. Trail intended to provide a rugged experience such as a cross country 

training trail with a steep grade or a challenge course with abrupt and 

severe changes in level. 

2. Where compliance with certain provisions would not provide the intended 

and desired level of challenge and difficulty to users.  

3. Trails that traverse over boulders and rocky outcrops where the purpose of 

the trail is to provide people with the opportunity to climb rocks. To 

remove the obstacles along the way or reroute the trail around the rocks 

would destroy the purpose of the trail. 

 Furthermore, compliance is not intended to negatively impact the unique 

characteristics of the natural setting.  
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1. People using primitive trails, for example, expect to experience the 

outdoor environment in a more natural state with limited or no 

development.  

a. Evidence of manufactured building materials or engineered 

construction techniques in such a setting could change its primitive 

character, and therefore, the user's experience. In these settings, 

compliance with specific technical provisions, for example those 

related to surface and tread obstacles, could destroy the 'natural' or 

'undeveloped' nature of the setting. Actions may also compromise 

the 'nature of the setting' such as constructing an imported surface 

on a trail in a remote location or removing ground vegetation in 

meadows or alpine areas. 

16.1.1.3 - Compliance would require construction methods or 

materials that are prohibited by federal, state, or local regulations or 

statutes  

 Where compliance would require construction methods or materials that are 

prohibited by federal, state, or local regulations or statutes. Examples of these conditions 

include: 

1. Federally designated and some State designated Wilderness Areas prohibit 

the use of mechanized equipment, limiting construction methods to hand 

tools.  

2. Imported materials may be prohibited to maintain the integrity of the 

natural ecosystem.  
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a. NOTE: This provision is not intended to automatically exempt 

organizations restricted under regulations or statutes from the 

technical provisions specified in Section 16. 

3. Aquatic features protected under Federal or State laws have limited 

allowable construction practices.  

a. For example, constructed water crossings required under the 

technical provisions might not be permitted under certain laws or 

regulations. Construction methods and materials employed in 

designated wetlands or coastal areas are also strictly limited. 

4. Local regulations and statutes address conditions where "conservation 

easement" or "development rights" programs prohibit or restrict 

construction methods and practices.  

a. For example, where land is purchased from farms, certain use 

restrictions may prohibit the importation of surfacing materials. On 

the other hand, local regulations or statutes may not be developed 

or initiated with the sole purpose of prohibiting use by people with 

disabilities. For example, initiating a new local regulation that 

arbitrarily restricts trail width to a dimension that would not allow 

passage of wheelchairs or other mobility devices is not permitted 

under this conditional departure. 
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16.1.1.4 - Where compliance would not be feasible due to terrain or 

the prevailing construction practices. 

 The term "not feasible" is used in this situation to specify what is "reasonably do-

able." It does not refer to the technical feasibility with the technical provisions.  

1. EXAMPLE 1: Providing a trail with a 1:20 slope or less up a 1,500 foot 

tall mountain using heavy construction equipment may be feasible, but the 

trail would be at least 5.8 miles long (rather than 2 miles long under a 

traditional back-country layout), and may cause inappropriate 

environmental and visual impacts. The intent of this conditional departure 

is to recognize that the effort and resources required to comply would be 

disproportionately high in relation to the level of access created. Although 

technically feasible, the effort and resources required are not "reasonable." 

2. EXAMPLE 2: Complying with the technical provisions, for running slope 

(16.2.7) in areas of steep terrain may require extensive cuts or fills that 

would be difficult to construct and maintain, or cause drainage and erosion 

problems. Also, in order to construct a trail on some steep slopes, the trail 

may become significantly longer causing a much greater impact on the 

environment. Certain soils are highly susceptible to erosion. Another 

example might be in areas where soils expand and dramatically contract 

with water content. If compliance requires techniques that conflict with 

the natural drainage or existing soil, the trail would be difficult, if not 

impossible, to maintain. 
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 This condition may also apply where construction methods for particularly 

difficult terrain or an obstacle would require the use of equipment other than that 

otherwise used throughout the length of the trail (i.e., techniques different from 

prevailing construction practices).  

1. EXAMPLE: Requiring the use of a bulldozer to remove a rock 

outcropping when hand tools are the commonly used method of 

construction for that trail. 

2. EXAMPLE: Where compliance with the provision for a firm and stable 

surface conflict with the prevailing construction practices by requiring the 

importation of a new surfacing material that would not otherwise have 

been used. If the prevailing construction practices would not include the 

importation of a new surface material and the natural surface material 

could not be made firm and stable, the trail would not be required to 

comply with that specific provision. 

Trail construction practices vary greatly, from the use of volunteer labor and hand tools, 

to professional construction with heavy mechanized equipment. For alterations to an 

existing trail, the "prevailing construction practices" are the methods typically used for 

construction or maintenance of the trail. The available resources and the environmental 

conditions (e.g., soil type and depth, vegetation, natural slope) primarily determine the 

"choice" of construction practices (e.g., machinery, skilled operators, finances). The 

intent of this conditional departure is to ensure that compliance with the technical 

provisions does not require the use of construction practices that are beyond the skills and 

resources of the trail building organization. It is not intended to automatically exempt an 
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organization from the technical provisions simply because of a particular construction 

practice, (e.g., the use of hand tools) or to suggest that hand tools can be selected as the 

tool of choice to avoid compliance when more expedient methods and resources are 

available. 

 16.2 – TRAILS   

Definition: What is a Trail? 

 A trail is a route that is designed, constructed, or designated for recreational 

pedestrian use or provided as a pedestrian alternative to vehicular routes within a 

transportation system. A trail does NOT include trails primarily designed for equestrians, 

mountain bicyclist, snowmobile users, or off-highway vehicle users, even if the 

pedestrians may occasionally use the same trails. Trails include, but are not limited to, a 

trail through a forested park, a shared use path, or a back country trail. Trails covered by 

16.2 do not include pathways such as sidewalks, pathways in amusement parks, 

commercial theme parks, carnivals, or between buildings. These exterior accessible 

routes are covered by ADAAG 4.3. 

Definition: What is a Designated Trailhead? 

 A designated trailhead is a designated point of access that may contain a parking 

area, information kiosks, restrooms, water hydrants, and may be reached by vehicular or 

pedestrian access.  
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Definition: What is a Tread Width? 

The tread width is the path or visible trail surface perpendicular to the direction of 

travel. The clear tread width of the trail is the width of the useable trail tread, measured 

perpendicular to the direction of travel and on or parallel to the surface of the useable trail 

tread. The minimum clear tread width is the narrowest measurement on the useable trail 

tread. 

16.2.1 Surface 

DEFINITION: What is a firm surface? 

 A firm surface is that of which does not give way significantly under pressure, i.e. 

walking in it.  An example of firm surface would be an asphalt walkway, and an example 

of a non-firm walkway would be of sand or loosely packed earth. 

 

Firmness classification 

Firm 

- Very Firm = 0.3 inch or less penetration 

- Moderately Firm = greater than 0.3 and less than 0.5 inch penetration 

Not Firm = greater than 0.5 inch penetration 
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DEFINITION: What is a stable surface? 

A stable surface is a surface that does not shift from side-to-side when turning on it.  An 

example of this is a stable surface is a asphalt walkway, and a non-stable surface would 

be made of sand or loosely packed earth 

 

Stability classification 

Stable 

- Very Stable = 0.5 inch or less penetration 

- Moderately Stable = greater than 0.5 and less than 1.0 inch penetration 

 

Not Stable = greater than 1.0 inch penetration 

Test Method for Firmness and Stability 

 The following test methodology is based on a preliminary test procedure for the 

measurement of surface firmness and stability which is one of the ways that firmness and 

stability can be measured. For more information, consult the "Accessible Exterior 

Surfaces Technical Report" available through the U. S. Access Board. 

Test Equipment 

 The recommended test equipment for determining firmness and stability on 

outdoor surfaces is the rotational penetrometer, a device consisting of three main 

components: penetrator, frame, and reference base. The penetrator consists of an 8 x 1¼ 

inch (20 cm x 3 cm) pneumatic caster and a means to press the caster into the surface 

with a known force. The frame is an attachment to the reference base that provides a 
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means for allowing the penetrator to move freely, perpendicular to the reference base. 

The reference base is a flat, rigid, surface used to position and anchor the testing 

equipment relative to the test surface. It has an area through which the penetrator can pass 

and rotate freely without hindering the movement of the surface material being tested or 

interfering with the test results. The reference base may also provide a platform for the 

device operator during testing. The rotational penetrometer is instrumented with a method 

to measure the amount of vertical displacement of the penetrator into the test surface. 

Test Procedure 

 To test surface firmness and stability, the rotational penetrometer is placed on the 

surface to be tested. A person stands on the reference base of the rotational penetrometer 

to stabilize its position during testing. The penetrator is lowered onto the test surface and 

an initial vertical displacement measurement is taken. A load of 44 ± 1 lbs. (20 ± 0.5 kg) 

is applied to the penetrator and then a second measurement of the amount of vertical 

displacement is completed. Then, with the load still applied, the penetrator caster is 

rotated through four 90 degree rotations about an axis perpendicular to the surface, 

alternating the direction of rotation (clockwise, counter-clockwise) after each 90 degree 

rotation. The final amount of vertical displacement is then measured. This test procedure 

is repeated on the same surface in a different test area until a total of five trials have been 

completed. 

 16.2.1 Requires that the surface of accessible trails to be firm and stable.   

1. Trails however do not have to be slip-resistant because it can not be 

guaranteed on an outdoor environment because of factor such as leaves 

rain and ice.  
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2. Examples of a firm surface that can comply with this are a concrete or 

asphalt path, and packed soil. 

3. A firm and stable surface can also be naturally occurring surface with 

some type of stability agents such as wooden planks, stone, grass and 

packed dirt.  

4. EXCEPTION: This provision does not have to be met if at least one of the 

conditions in proposed section 16.1.1  applies 

16.2.2 – Clear Trail Tread 

 A clear trailhead requires that the width of a trail be at the least 36 inches of clear 

space that has a solid and firm surface. 

1. EXCEPTION:  Allows for a 32 inch minimum width if one of the 

provisions from 16.1.1 applies to a path 

2. EXCEPTION:  Allows for departure from the 32 inch minimum from the 

previous exception if the width of the path can not be provided because of 

one or more of the conditions stated in 16.1.1  

16.2.3 – Openings in the Surface of a Trail 

 Requires that if you have an opening in a path, like a drain for example, that it can 

not allow the passage of a ½ diameter object to pass threw it.   

1. Elongated opening must be placed so that the elongated opening are 

placed perpendicular or diagonal to the dominate direction of travel.   

2. EXCEPTION 1:  Elongated opening can be parallel to a path if the do not 

allow the passage of a ¼ inch diameter object. 
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a. Example – A wooden path like a bridge or a walkway, over some 

wetlands. 

3. EXCEPTION 2: Allows for opening of ¾ inch diameter where one or 

more conditions of 16.1.1 apply. 

a. Example – A Wooden path needs proper room for expansion and 

contraction because of weather conditions, and for proper drainage.  

A ½ inch open space may be normal, but during the winter or 

colder months, the boards will contract, and the opening will be 

more than ½ of an inch. 

4. EXCEPTION 3: Allows for departure from this provision if a ¾ inch 

diameter opening is not feasible due to at least one of the four conditions 

of 16.1.1. 

16.2.4 – Protruding objects 

 Requires that all protruding objects on a trail, i.e. signs, trees, other such objects, 

shall have a minimum of 80 inches of clear head room. 

1. If a object has less than 80 inches of clear head room because of one of the 

four condition of 16.1.1, then there must be some type of barrier to warn 

the blind or visually impaired of the low height of the object.   

a. This allows for a trail to pass threw things like caves or ledges to 

provide these experience to disabled people.  

2. THERE IS NO DEPATURE FROM THIS PROVISION 
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16.2.5 – Tread Obstacles (Changes in Level) 

 Requires that no tread obstacle shall exceed a maximum of two inches in height.  

Tread obstacles are natural features, such as roots, rocks, and ruts that cannot be avoided.  

1. EXCEPTION 1: Permits of height of three inches where a running and 

cross slopes are 1:20 or less. 

2. EXCEPTION 2: Permits the height of more than three inches where a 

condition in 16.1.1 applies. 

16.2.6 – Passing Space 

 Require that a passing space be provided where the clear tread width of a path is 

less than 60 inches every 1000 feet maximum.   

1. A T-shaped intersection or a turning circle is all so permitted in this 

proposition. 

2. CONSIDERATION: The provision of more frequent passing spaces 

should also be considered in areas with steep or difficult terrain or limited 

sight lines, so that users do not have to back up long distances to reach a 

passing space.  

3. CONSIDERATION: More frequent passing intervals should also be 

considered on trails with heavier use, especially closer to trailheads and 

prominent features.  

4. If a bridge that is less than 60 inched wide is provided, a 60 x 60 inch 

minimum passing space should be provided at either end of the bridge.  
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5. Passing intervals may be located to one side of the trail and/or co-located 

with resting intervals. 

6. EXCEPTION:  Permits departure from this provision where clear space 

can not be provided because of one or more of the conditions provided in 

16.1.1. 

16.2.7 – Slopes (Cross and Running Slopes) 

Definition: What is a cross slope? 

 A cross slope is the slope that is perpendicular to the direction of travel, i.e a slope 

from side to side. 

Definition: What is a running slope? 

 A running slope is the slope that is parallel to the direction of travel, i.e. a slope in 

the middle of a path leading to a drain. 

 16.2.7.1 will address cross slope, an d 16.2.7.2 will address running slopes 

1. EXCEPTION 1: Open drain structures 

a. A running slop of 14% is permitted for a distance of 5 feet 

maximum with a cross slope of 1:20 

2. EXCEPTION 2: Cross slopes at the bottom of an open drain is permitted 

to be 1:10 where the clear tread width is 42 inches or more. 

3. EXCEPTION 3: Permits departure from 16.2.7 where one of more 

conditions of 16.1.1 exists. 

4. Handrails are not required on trails, no matter the slope, instead of 

handrails, the use of resting intervals are used.   
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16.2.7.1 – Cross Slope 

 Requires that the maximum cross slope of a trail segment be at maximum 1:20. 

Trail cross slope is the angle of the trail tread perpendicular to the direction of travel (the 

side to side slope of the trail). The recommended unit of measurement is percent or rise 

over run (e.g., 2% or 1:50). Cross slope measurements should be determined across a 24 

inches width, at intervals not exceeding 100 feet in length, from the trail head to the 

destination. Cross slope measurements are taken perpendicular to the path of travel over 

the most level section of tread at each point. 

16.2.7.2 – Running Slope  

 Requires that trail segments shall comply with one or more of the provisions of 

this section, and no more than 30% of the total length of the train shall exceed a running 

distance of 1:12.  The running slope represents the steepness of individual segments of 

the trail and should be measured parallel to the direction of travel. The recommended unit 

of measurement is percent or rise over run (e.g., 2% or 1:50). Uphill and downhill trail 

segments should be measured separately. The distance measured may be as short as 10 

feet, but should not exceed 100 feet in length. The running slope should be measured for 

each consecutive trail segment, from the trail head to the destination. 

 16.2.7.2.1  

  Permits a running slope of 1:20 or less for any distance. 
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 16.2.7.2.2 

 Permits a running slope of 1:12 maximum for 200 feet maximum  Resting 

intervals complying with 16.2.8 (Resting Intervals) should be no greater than 200 

feet apart.  

 16.2.7.2.3  

 Permits a running slope of 1:10 maximum for 30 feet maximum.  Resting 

intervals complying with 16.2.8 (Resting Intervals) should be no greater than 30 

feet apart.  

 16.2.7.2.4 

 Permits running slope of 1:8 maximum for 10 feet maximum  Resting 

intervals complying with 16.2.8 (Resting Intervals) should be no greater than 10 

feet apart.  

16.2.8 – Resting Intervals 

 Requires that resting interval be 60 inches in length and as wide as the widest 

portion on the trial segment leading to the resting interval.  

1. Resting intervals should be provided between uphill and downhill trail 

segments if the running slope for either segment exceeds 1:12, as well as 

at intervals on a continuous slope as specified by 16.2.7.2 (Running 

Slope).  

2. Rest intervals should be positioned so that a smooth, gradual transition is 

provided between running slope segments.  
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3. Rest intervals may be located within the trail tread. However, locating the 

rest interval outside of the main path of travel will ensure that users who 

are resting are not at risk of collisions with other trail users.  

4. EXCEPTION: Permits departure from this condition where at least one of 

the conditions are meet in 16.1.1. 

16.2.9 – Edge Protection 

 Does not require edge protection to be on accessible trails. 

1. Where provided however, must be a minimum of 3 inches in height. 

2. The higher edge protection is required because trail surfaces are likely to 

have natural variations in the height of the surface. As a result, people 

with limited vision using navigation canes may search or scan at a higher 

level in natural outdoor environments than they would in an indoor 

environment. The higher edge protection will assist in its detection and 

identification and help to distinguish it from variations in the natural 

surface of the outdoor environment. 

16.2.10 – Signs 

 Requires signs on all newly constructed or altered trails and trail segments that 

they comply with all the technical provisions of 16.2 to be designated with a symbol at 

the trail head or designated access points.  Signs that identify accessible trail segments 

shall include the total distance of the accessible segment and be located at the first point 

of departure. 
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1. CONSIDERATION: Given the wide variability in the actual trail 

characteristics that may be encountered on a trail, it is strongly 

recommended that objective information about the actual trail conditions 

be provided for all trails, whether or not they are accessible.  

a. Objective information about actual trail condition for all trails will 

assist users in determining whether the trail meets their own 

abilities.  

 

2. CONSIDERATION: That the location of specific trail features and 

obstacles that do not comply with accessibility provisions be identified 

and that a profile of the trail grade and surface be included. 

 

3. Items to include on a sign for trails that comply with the ADAAG 

specifications for recreational trails it is recommended that the following 

additional information be provided: 

a. Trail Symbol 

b. Running slope (average and maximum) 

c. Cross slope (maximum) 

d. Clear Tread Width (minimum) 

e. Surface type 

f. Trail length 

g. Trail elevation ( at trailhead) 

h. Maximum elevation attained 
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4. Trails that do not comply with one or more provisions of the ADAAG 

Technical Specifications for Recreational Trails (Section 16.2, including 

exemption levels): 

a. Running slope (average and maximum) 

b. Cross slope (average and maximum) 

c. Clear tread width (minimum and average) 

d. Surface type, firmness, and stability 

e. Tread obstacles (magnitude and frequency) 

f. Trail length 

g. Trail elevation (at trailhead) 

h. Total elevation change 

MAXIMUM AND LOWEST ELEVATION ATTAINED16.3 – OUTDOOR 

RECREATION ACCESS ROUTE 

Definition: What is an Outdoor Recreation Access Route? 

 An outdoor recreation access route is a continuous unobstructed path that is 

designated for pedestrian use and is used to connect accessible elements within a park 

such as picnic areas, camping areas, or a designated trailhead.  For example, a path that 

connects a parking area with a picnic area or a picnic area to a bathroom facility is 

considered an outdoor recreation access route.   
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1. Outdoor recreation access route do not do not include pathways such as 

sidewalks or other pathways addressed in ADAAG 4.3 (sidewalks only 

pathway relevant to Brookline’s parks). 

2. Outdoor recreation access routes are required to connect elements that are 

required to be accessible.  For example, where a cooking grill and a picnic 

table are provided in a park, an outdoor recreation route is required to 

connect these elements.  

3. Elements located along a trail (benches, picnic tables, etc.) are not 

required to be connected by an outdoor recreation access route 

16.3.1 – Surface 

 Requires that the surface of the outdoor recreation access route be firm and stable.   

 

16.3.2 – Clear Tread Width 

 Requires that the width of an outdoor recreation access route to be a minimum of 

36 inches. 

1. EXCEPTION: Where an outdoor recreation access route meets one or 

more of the conditions of 16.1.1, a minimum of 32 inches for a distance of 

24 inches is allowed. 

16.3.3 – Openings 

 An opening is that of a hole in the ground weather it is for drainage or some other 

type of application.   

 111



1. Openings can not be larger that a ½ an inch in diameter.   

2. If you have a drain for example in place, the elongated opening must be 

placed so that it is perpendicular or diagonal to the dominate direction of 

travel. 

a. Required so that it is not possible for cane tips, wheelchair wheels, 

or skate wheels to get caught. 

b. EXCEPTION: If an opening is less than ¼ inches in diameter, than 

the openings can run parallel to the dominate direction of the path.   

16.3.4 – Protruding Objects 

 Requires that protruding objects on an outdoor recreation access route follow 

ADAGG 4.4 (external link) – link to guideline:  

Below are items that are relevant to parks: 

1. A vertical clearance of 80 inches minimum clear head room  

a. If vertical clearance of an area adjoining an accessible route is 

reduced to less than 80 inches, a low lying tree for example, a 

barrier to warn blind or visually-impaired people shall be provided. 

2. Free-standing objects mounted on posts or pylons may overhang 12 in 

maximum and be 27 in to 80 from the ground.  

a. This is so that a blind person’s cane will hit the pylon or post first 

before he/she does. 

3. Protruding objects shall not reduce the clear width of an accessible route 

or maneuvering space. Path must still remain clear for a minimum 36 

inches as stated in 16.3.2 (Clear Tread Width). 
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16.3.5 – Tread Obstacles 

 An example of a tread obstacle is that of surface material changes such as from 

asphalt to a concrete slab. 

1. A tread obstacle can not exceed a one inch maximum height. 

2. EXCEPTION: May be increased to a two inch maximum height if the 

tread obstacle is beveled and meets at least one of the conditions of 16.1.1 

3. If over two inches, a ramp must be installed in order to be compliant. 

16.3.6 – Passing Space 

 Requires a passing space for outdoor recreation access path that are less than 60 

inches in width.   

1. A passing space can either be a space of 60 by 60 inches along a path or a 

T shaped intersection complying with ADDAG 4.2.3. 

a. 4.2.3 states that the arms and stem of the T shaped path must 

extend at least 48 inches beyond the intersection. 

2. Required in intervals of 200 feet maximum. 

3. EXCEPTION: A passing space may be increased to 300 foot intervals if it 

is not possible to provide a passing space within the 200 feet because of an 

environmentally sensitive area for example. 

16.3.7 - Slopes 

 Addresses both cross slopes as well as running slopes. 

 113



16.3.7.1 – Cross Slope 

 Permits a maximum of 1:33 cross slope for outdoor recreation access routes.  

1. EXCEPTION: A 1:20 slope is allowed when required for proper drainage 

only.  This is only to prevent water ponding on an outdoor recreation 

access route. 

16.3.7.2 – Running Slope 

 Designers have a choice of what technical provision that they may apply. 

 16.3.7.2.1  

Permits a maximum of or 1:20 slope for any distance along an outdoor 

recreation access route. 

  

 16.3.7.2.2  

Permits a maximum of a 1:12 slope for a distance of no more than 50 feet. 

Resting areas must be made present at a distance no greater that 50 feet apart and 

comply with section 16.2.8 (Resting Intervals) 

 16.3.7.2.3 

Permits a maximum of a 1:10 slope for a distance of no more than 30 feet. 

Resting areas must be made present at a distance no greater than 30 feet apart and 

comply with section 16.2.8 (Resting Intervals) 
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16.3.8 – Resting Intervals 

 Requires that all resting intervals along an outdoor recreation route to be no less 

than 60 inches in length and have a width as wide as the route connecting it, i.e. if the 

path is 36 inches wide, the resting area has to also be 36 inches wide or greater. 

1. EXCEPTION: Permits a 1:20 slope where surface conditions require it for 

proper drainage. 

16.3.9 – Edge Protection 

 Requires that where edge protection is present, it must have a minimum height of 

3 inches.  

16.5 - FIXED PICNIC TABLES 

Definition: What is a fixed picnic table? 

A picnic table that is “fixed” to the ground, (i.e. permanently attached to the 

ground by being bolted down, having a concrete footing, or chained to the ground). 

Definition: What is a picnic area? 

 A picnic area is an area that is designated as a location where picnic related 

elements are located, i.e. picnic table. An outdoor developed area can contain several 

different picnic areas.  For example, one picnic area can be located next to a lake in a 

park, and a picnic area at a pavilion is a different area of the park would be considered 

two separate picnic areas.  Picnic areas can also be separated by designation of different 

names or being connected to a separate entrance road. 
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16.5.1 - Compliance per Number of Picnic Tables 

16.5.1.1- Single Picnic Table  

 Requires that if one bench is present in a picnic area, then it has to be accessible 

an comply with 16.5 

2. Table must be located along an outdoor recreation access route that 

complies with 16.3 (Outdoor Recreation Access Route). 

16.5.1.2 – Multiple Picnic Tables 

 Requires that where there are two or more picnic tables in a picnic area, that at 

least 50% of the picnic tables must be accessible and comply with 16.5 

1. EXCEPTION: - If there are only two picnic tables, in this case both must 

be accessible and be located along an outdoor recreation access route that 

complies with 16.3 (Outdoor Recreation Access Route). 

2. If there are more than two picnic tables, of the picnic tables that are 

required to be accessible, 40% of them must be located on an outdoor 

recreation access route that complies with 16.3 (Outdoor Recreation 

Access Route) 

3. Example – If there are 10 picnic tables in an area, five tables would be 

required to be accessible, and 40% of them, or two picnic tables MUST be 

located on an outdoor recreation access route that complies with 16.3 

(Outdoor Recreation Access Route).  The other accessible benches are not 

required to be on a access route, but are required to have some type of 

ADA compliant path leading to them, i.e. a path made of Fibar. 
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16.5.2 – Dispersal of Tables 

 Requires that accessible picnic tables be dispersed among the various types of 

picnic settings or opportunities that a picnic area provides.   

 For example, a particular picnic area may offer picnic sites near the lake, in the 

woods, and in the open, sunny portion of the area. This provision requires that the 

number of accessible tables be distributed throughout the area, so that people with 

disabilities would have a choice of picnic locations similar to what other visitors to the 

area have. This section would not increase the total number of accessible tables required 

in 16.5.1.2(Multiple Picnic Tables). Using the previous example, if you have four picnic 

tables in an area, two of which need to be accessible as stated as 16.5.1.2(Multiple Picnic 

Tables, and have three different sites included in that picnic area, you still only need to 

have two of the picnic tables accessible even though there are three different settings in 

the picnic area. 

16.5.3 – Number of Wheelchair Seating Spaces 

 Requires that with each accessible picnic table, there be at least one wheelchair 

seating space  

1. Where a picnic table that has a table top perimeter of less than 24 linear 

feet, one wheelchair seating space is required. 

2. Where a picnic table that has a table top perimeter of more than 24 linear 

feet, the following table provides the number of wheelchair seats required: 

Table Top Linear Feet Number of Wheelchair Spaces 
25 lf - 44 lf 2 spaces 

45 lf - 64 lf 3 spaces 
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65 lf - 84 lf 4 spaces 

85 lf – 104 lf 5 spaces 
 

3. Location of the seating spaces is left up to the discretion of the discretion 

of the designer of the picnic table, although it is recommend to spread of 

the spot throughout the picnic table rather than clustered in one location, 

but it not required for compliancy. 

 

16.5.4 – Wheelchair Seating Space Size 

 Requires that each accessible seating space must provide knee space of at least 30 

inches wide, 24 inches deep, and 27 inches from the ground/floor to the bottom of the 

table top 

1. NOTE: There is an addition five inches of depth added on to the toe space 

of the seating space because of the solid leg on each end of the table.  A 

19-inch deep space at the end of a solid leg table would not allow a person 

using a wheelchair to be sufficiently close to the table. 

16.5.5 – Table Clearance 

 Requires a 36 inch minimum clear space surrounding the useable portions of an 

accessible table, measured from the outside edge of the seat, or the outside edge of the 

table if no seat is provided. 
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16.5.6 – Surface 

 Requires that the surface of the clear space and accessible seating space to be firm 

and stable.   

1. Slip resistance surfaces are not required because of outside factors such as: 

a. Tree leaves and needles 

b. Duff (partly decayed organic material on the forest floor) 

c. Mud  

d. Snow 

e. Ice  

f. Other such factors that often cover outdoor areas.   

2. EXCEPTION: This provision does not have to be met if at least one of the 

conditions in proposed section 16.1.1 applies 

16.5.7- Slope 

 Requires that the slope of the required clear spaces may not exceed 1:50 in any 

direction. 

1. EXCEPTION 1: On a natural or natural-appearing surface that are often 

used in picnic areas, a 1:50 slope may not be adequate for proper drainage.  

In this case a maximum slope of 1:33 in any direction is allowed. 

2. EXCEPTION 2: This provision does not have to be met if at least one of 

the conditions in proposed section 16.1.1 applies. 

.   
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16.7 – COOKING SURFACES, GRILLS PEDESTAL 

GRILLS 

16.7.1 – Minimum number 

16.7.1.1 – Single Cooking Surface 

 Requires that where one cooking surface, grill or pedestal grill is provided in an 

area, it must comply with 16.7.3 through 16.7.7 and shall be connected to an outdoor 

recreational access route complying with 16.3 (Outdoor Recreation Access Route). 

 

16.7.1.2 – Multiple Cooking Surfaces 

 Requires that where two or more cooking surfaces, grills or pedestal grills are 

provided in a area, at least 50%, but never less than 2, shall comply with 16.7.3 – 16.7.7.  

Also, like picnic tables, 40%, but never less than two, must be located on an outdoor 

recreational access route and comply with 16.3 (Outdoor Recreation Access Route). 

 

16.7.2 – Dispersal 

 Requires that accessible cooking surfaces shall be dispersed among the types 

provided. This not just includes dispersing the accessible cooking surfaces around the 

cooking areas, but also the different types.  If you have 3 of each type of cooking surface, 
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at least one of each must be accessible.  This doe not require however, an increase in the 

total number of accessible cooking surfaces required in 16.7.2. 

 

16.7.3 – Cooking Surface Height 

 Requires that the surface height of the cooking surfaces must be installed between 

15 and 34 inches above the ground.   

1. 34 inches is consistent with counter tops in homes. 

2. 15 inches is consistent with the minimum low forward reach stated in 

ADAAG 4.2.5. 

16.7.4 - Operating Controls and Mechanisms 

 Requires operation controls, if any, of the containers to comply with ADAAG 

4.27.1 (General), 4.27.2 (Clear Floor Space) and 4.27.3 (Height): 

1. 4.27.2 - Clear floor space complying with 4.2.4 that allows a forward or a 

parallel approach by a person using a wheelchair shall be provided at 

controls, dispensers, receptacles, and other operable equipment.  

2. 4.27.3 - The highest operable part of controls, dispensers, receptacles, and 

other operable equipment  

a. Placed under 48 inches but over 15inches of the ground if allowing 

for forward approach  

b. Placed under 54 inches but over 9 inches of the ground if allowing 

for parallel use  
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c. EXCEPTION: These requirements do not apply where the use of 

special equipment dictates otherwise. 

3. Is not reasonable or feasible in the outdoor environment because elements 

must be vandal-resistant, large animal resistant and adaptable to weather 

conditions of extreme heat, cold, and moisture. 

16.7.5 – Clear Floor or Ground Space 

 Requires that a minimum clear space of 48 inches deep by 48 inches wide to be 

provided at all useable portions of the cooking surface, grill or pedestal grill.   

1. This allows for front and parallel approach. 

2. If one or more of the conditions of 16.1.1 apply, then the clear space 

requirements can be reduced to no less than 36 by 36 inches space  

16.7.6 – SLOPES 

 Requires that with like picnic tables, the slope of the clear space at useable 

portions of the cooking surfaces, grills, and pedestal grills to not exceed 1:50 in any 

direction.   

1. It is permitted to have a slope of 1:33 if for the use of drainage. 

2. This provision does not have to be met if at least one of the conditions in 

proposed section 16.1.1 applies. 

16.7.7 – SURFACE 

 Requires that the surface that is defined in 16.7.5 shall be stable and firm. 
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1. This provision does not have to be met if at least one of the conditions in 

proposed section 16.1.1 applies. 

16.8 – FIXED TRASH/RECYCLING CONTAINERS 

Definition: What are Fixed Trash/ Recycling Containers? 

 A fixed trash container is a trash barrel that is attached to the ground via footings 

or being bolted down to it.  The same is of a recycling container, but it is use for only the 

disposal of recyclable material such as paper, plastics and metals. 

 16.8 requires that all trash and recycling containers to be accessible and comply 

with the following: 

1. Accessible clear space that allows a forward or a parallel approach by a 

person using a wheelchair shall be provided. 

2. Maximum height of a container shall be 54 inches. 

16.8.1 – Accessibility of Trash and Recycling Containers 

 ALL trash and/or recycling container provided be accessible.   

1. It is considered to be a health issue, so it is imperative that all containers 

meet the provisions for accessibility. 

2. EXCEPTION: If a trash or recycle bin is a multi-bin container, having 

more than one compartment, then only 50% of the multi-bin needs to be 

accessible. 
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16.8.2 – Clear Space around Trash and Recycling Containers 

 Requires that clear space of trash and/or recycling containers comply with 

ADAAG 4.2.4.1 and 4.2.4.2 which state: 

1. 4.2.4.1 - The minimum ground space required to accommodate a single, 

stationary wheelchair and occupant is 30 in by 48. 

a. The minimum ground space for wheelchairs may be positioned for 

forward or parallel approach to an object. 

2. 4.2.4.2 - One full unobstructed side of the ground space for a wheelchair 

shall adjoin or overlap an accessible route or adjoin another wheelchair 

clear floor space.  

a. If a clear floor space is located in an alcove or otherwise confined 

on all or part of three sides, additional maneuvering clearances 

shall be provided, i.e. more space to allow for turning around. 

16.8.3 – Surface 

 Requires that the surface of the outdoor recreation access route be firm and stable.   

1. EXCEPTION: This provision does not have to be met if at least one of the 

conditions in proposed section 16.1.1 applies. 

16.8.4 – Slope 

 Requires the slope of the clear space to be no greater than 1:50. 

1. EXCEPTION: Permits a 1:33 maximum slope where surface conditions 

require it for proper drainage.   
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2. EXCEPTION: This provision does not have to be met if at least one of the 

conditions in proposed section 16.1.1 applies. 

16.8.5 Controls and Operating Mechanisms 

 Requires operation controls, if any, of the containers to comply with ADAAG 

4.27.3 and 4.27.4 which state: 

3. 4.27.3 - The highest operable part of controls, dispensers, receptacles, and 

other operable equipment  

a. Placed under 48 inches but over 15inches of the ground if allowing 

for forward approach  

b. Placed under 54 inches but over 9 inches of the ground if allowing 

for parallel use  

c. EXCEPTION: These requirements do not apply where the use of 

special equipment dictates otherwise. 

4. 4.27.4 - Controls and operating mechanisms shall be operable with one 

hand and shall not require tight grasping, pinching, or twisting of the 

wrist.  

a. The force required to activate controls shall be no greater than 5lb 

of force. 

5. EXCEPTION: 4.27.4 does not apply is using hinged, sliding or other type 

of lids and/or controls designed for large animal exclusion. 

a. It is a necessity to protect the health of the user and of the animal 

population, thus this overrides these accessibility requirements. 
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b. The U.S.D.A. Forest Service Technology and Training Center (San 

Dimas, CA) has issued a document which provides information 

about animal resistant garbage containers. Suggested designs may 

be useful in complying with these provisions ; #9523 1205 SDTDC 

444 East Bonita Ave. San Dimas, CA 91773 

16.10 - OVERLOOKS/VIEWING AREAS 

16.10.1 Number of Accessible Viewing Areas 

Where viewing areas are provided on designated overlooks, each viewing area 

shall comply with 16.10.2 through 16.10.5 and be located on an outdoor recreation access 

route complying with 16.3 or a trail complying with 16.2. 

1. EXCEPTION: Where multiple viewing areas are provided, a minimum of 

one of each viewing opportunity for distinct points of interest shall be 

accessible. 

2. EXCEPTION: This provision does not have to be met if at least one or 

more of the conditions in 16.1.1 apply. 

16.10.2 Maneuvering Space 

The viewing area shall have at least one maneuvering space complying with 

ADAAG 4.2.3. 

16.10.3 Unrestricted Viewing Opportunities 

 Each location providing viewing opportunities for distinct points of interest shall 

provide at least one unrestricted viewing opportunity for each distinct point of interest. 
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Viewing opportunities shall accommodate eye levels between 32 inches (815 mm) 

minimum to 51 inches (1295 mm) maximum. 

1. EXCEPTION. The provisions of does not have to be met if at least one or 

more of the conditions in 16.1.1 applies. 

16.10.4 Slope. 

The maneuvering space required by 16.10.2 shall have a slope which does not 

exceed 1:50 in any direction. 

1. EXCEPTION:  Where surface conditions require slopes greater than 1:50 

for proper drainage, a 1:33 maximum slope is allowed.  

2. EXCEPTION: The provisions of 16.10.4 do not apply where at least one 

of the conditions in 16.1.1 applies. 

16.10.5 Surface. 

The surface of clear space required by 16.10.2 shall be stable and firm.  

1. EXCEPTION. The provisions of 16.10.5 do not apply where at least one 

of the conditions in 16.1.1 applies. 
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16.12 – FIXED BENCHES  

16.12.1 – Minimum Number of Benches 

16.12.1.1- Single Bench 

 Requires that is only one bench present in a park that it must be used by all 

visitors and therefore must be accessible and comply with 16.12.2 - 16.12.8 as well as 

have one armrest can handle 250 pounds of force as well as not rotate in its fitting as 

stated an ADAAG 4.26.3 to facilitate its use.  

16.12.1.2 – Multiple Benches 

  Requires that at least 50% of the fixed benches in an area must be accessible and 

meet the proposed provisions in the section.   

1. Of the required 50% of fixed benches that are accessible, at least 50% of 

those MUST provided an armrest complying with ADAAG 4.26.3. 

a. Example, if you have 20 fixed benches in your park, 10 of them 

need to be accessible.  If you make 15 of them accessible, only 5 of 

them need to have armrest that comply with ADAAG 4.26.3 

because only 50% of the 50% of the required fixed benches that 

need to be accessible need to comply with this proposed provision. 

b. Of the benches that are required to be compliant, 40% of them 

have to be located to an outdoor recreation access route complying 

with 16.3. 
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16.12.2 –Fixed Bench Dispersal 

 Requires that of the total accessible benches that are an area, they have to be 

spread out into a variety of places. 

2. This provision does not require you to add additional benches.  

a. If you have three different areas of your park, and only four 

benches throughout the park, only two still need to accessible, but 

both accessible benches need to be in a different area of the park. 

16.12.3 – Height of Fix Bench 

 Requires that the front edge of the bench seat to be between 17 inches and 19 

inches above the ground.   

16.12.4 – Space Requirement around Fixed Bench 

 Requires that at least one clear ground space that is compliment with ADAAG 

4.2.4. ADAAG 4.2.4 states: 

1. 4.2.4.1 - The minimum ground space required to accommodate a single, 

stationary wheelchair and occupant is 30 inches by 48 inches. 

b. The minimum ground space for wheelchairs may be positioned for 

forward or parallel approach to an object. 

2. 4.2.4.2 - One full unobstructed side of the ground space for a wheelchair 

shall adjoin or overlap an accessible route or adjoin another wheelchair 

clear floor space.  
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c. If a clear floor space is located in an alcove or otherwise confined 

on all or part of three sides, additional maneuvering clearances 

shall be provided, i.e. more space to allow for turning around. 

3. 4.2.4.3 - clear floor or ground spaces for wheelchairs shall comply with 

4.5 

a. 4.5.2 - Changes in level up to 1/4 in may be vertical and without 

edge treatment. Changes in level between 1/4 in and 1/2 in shall be 

beveled with a slope no greater than 1:2. Changes in level greater 

than 1/2 in (13 mm) shall be accomplished by means of a ramp that 

complies with 4.7 or 4.8. 

b. 4.5.4 - Gratings. If gratings are located in walking surfaces, then 

they shall have spaces no greater than 1/2 in wide in one direction.  

If gratings have elongated openings, then they shall be placed so 

that the long dimension is perpendicular to the dominant direction 

of travel. 

Space should not overlap another clear space requirement. 

1. Example: If a picnic table is located near the bench, the bench can not be 

in the picnic tables 36 inch clear space, it must have its own clear space 

and not include in its clear space that of any surrounding element’s clear 

space. 

16.12.5 – Back Support 

 Back support must be provided on each bench, and must be the full length of the 

bench. 
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16.12.6 – Surface Conditions 

 Requires that the surface of the clear space for the bench be firm and stable. 

1. EXCEPTION:  If one of the conditions of 16.1.1 exists, this provision 

does not apply. 

16.12.7 – Slope 

 Requires that the slope of the clear space not exceed 1:50 in any direction. 

1. EXCEPTION: Permits a 1:33 maximum slope where surface conditions 

require it for proper drainage.   

a. It is important for the stability of the occupant of the clear space 

that the surface condition provides adequate support. 

2. EXCEPTION: This provision does not have to be met if at least one of the 

conditions in proposed section 16.1.1 applies. 

16.12.8 – Armrest 

 Requires that an accessible bench have at least one armrest and shall comply with 

ADAAG 4.26.3 which states that an armrest must be able to handle 250 pounds of force 

as well as not rotate in its fitting. 
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16.16 – UTILITIES 

16.16.1 Utility Accessibility 

 Requires that all utilities such as electricity, water, sewage and other similar types 

of utilities be comply with 16.16.2 through 16.16.5 of this proposition. 

16.16.2 – Controls and Operating Mechanisms 

 Requires that all controls and operating mechanisms shall comply with ADAAG 

4.27 (Controls and Operating Mechanisms). 

1. EXCEPTION: ADAAG 4.27.3 and 4.27.4 which state that there needs to 

be a certain clear space around the object as well as height requirements 

do not apply to sewage hookups. 

2. EXCEPTION: ADAAG 4.27.4 which states that all controls and operating 

mechanisms shall be operable with one hand and shall not require tight 

grasping, pinching, or twisting of the wrist does not apply to hand pumps. 

16.16.3 – Water Spouts 

 Requires that all fixed water spouts (drinking fountains) to be located between 28 

and 36 inches off the ground as well as have be centered at the edge of a minimum 60 

inch by 60 inch clear space. 

16.16.4 – Slopes 

 Requires that slopes of the clear spaces required by 16.16.2 and 16.16.3 have a 

maximum slope of 1:50. 
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1. EXCEPTION: Permits a 1:33 maximum slope where surface conditions 

require it for proper drainage.   

16.16.5 – Surface 

 Requires the surface of 16.16.2 and 16.16.3 to be firm and stable. 
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REFERENCE: ADAAG GUIDELINES OFTEN REFERRED 

TO IN THIS DOCUMENT  

 Items contained here were not summarized as part of this document.  They are 

directly from the ADA site located at http://www.access-

board.gov/adaag/html/adaag.htm. They are here for your reference and clarity to them 

being referred to in the body of the document.  To help keep this document short 

however, we have taken some irrelevant information that did not pertain to parks and 

open spaces out of this section. 

 

4.2 SPACE ALLOWANCE AND REACH RANGES 

4.2.1 Wheelchair Passage Width 

 The minimum clear width for single wheelchair passage shall be 32 in (815 mm) 

at a point and 36 in (915 mm) continuously (see Fig. 1 and 24(e)). Appendix Note 

4.2.2 Width for Wheelchair Passing 

 
The minimum width for two wheelchairs to pass is 60 in (1525 mm) (see Fig. 2). 

4.2.3 Wheelchair Turning Space 
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. The space required for a wheelchair to make a 180-degree turn is a clear space of 

60 in (1525 mm) diameter (see Fig. 3(a)) or a T-shaped space (see Fig. 3(b)). Appendix 

Note 

4.2.4 Clear Floor or Ground Space for Wheelchairs 

4.2.4.1 Size and Approach 

 The minimum clear floor or ground space required to accommodate a single, 

stationary wheelchair and occupant is 30 in by 48 in (760 mm by 1220 mm) (see Fig. 

4(a)). The minimum clear floor or ground space for wheelchairs may be positioned for 

forward or parallel approach to an object (see Fig. 4(b) and (c)). Clear floor or ground 

space for wheelchairs may be part of the knee space required under some objects. 

4.2.4.2 Relationship of Maneuvering Clearance to Wheelchair Spaces 

 One full unobstructed side of the clear floor or ground space for a wheelchair 

shall adjoin or overlap an accessible route or adjoin another wheelchair clear floor space. 

If a clear floor space is located in an alcove or otherwise confined on all or part of three 

sides, additional maneuvering clearances shall be provided as shown in Fig. 4(d) and (e). 

4.2.4.3 Surfaces for Wheelchair Spaces. Clear floor or ground spaces for wheelchairs 

shall comply with 4.5. Appendix Note 

4.2.5 Forward Reach 

If the clear floor space only allows forward approach to an object, the maximum 

high forward reach allowed shall be 48 in (1220 mm) (see Fig. 5(a)). The minimum low 
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forward reach is 15 in (380 mm). If the high forward reach is over an obstruction, reach 

and clearances shall be as shown in Fig. 5(b). Appendix Note 

4.2.6 Side Reach 

If the clear floor space allows parallel approach by a person in a wheelchair, the 

maximum high side reach allowed shall be 54 in (1370 mm) and the low side reach shall 

be no less than 9 in (230 mm) above the floor (Fig. 6(a) and (b)). If the side reach is over 

an obstruction, the reach and clearances shall be as shown in Fig 6(c). Appendix Note 

4.3 ACCESSIBLE ROUTE 

4.3.1 General 

All walks, halls, corridors, aisles, skywalks, tunnels, and other spaces that are part 

of an accessible route shall comply with 4.3. Appendix Note 

4.3.2 Location. 

1. At least one accessible route within the boundary of the site shall be 

provided from public transportation stops, accessible parking, and 

accessible passenger loading zones, and public streets or sidewalks to the 

accessible building entrance they serve. The accessible route shall, to the 

maximum extent feasible, coincide with the route for the general public. 

2. At least one accessible route shall connect accessible buildings, facilities, 

elements, and spaces that are on the same site. 
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3. At least one accessible route shall connect accessible building or facility 

entrances with all accessible spaces and elements and with all accessible 

dwelling units within the building or facility. 

4. An accessible route shall connect at least one accessible entrance of each 

accessible dwelling unit with those exterior and interior spaces and 

facilities that serve the accessible dwelling unit. 

4.3.3 Width 

The minimum clear width of an accessible route shall be 36 in (915 mm) except at 

doors (see 4.13.5 and 4.13.6). If a person in a wheelchair must make a turn around an 

obstruction, the minimum clear width of the accessible route shall be as shown in Fig. 

7(a) and (b). 

4.3.4 Passing Space 

If an accessible route has less than 60 in (1525 mm) clear width, then passing 

spaces at least 60 in by 60 in (1525 mm by 1525 mm) shall be located at reasonable 

intervals not to exceed 200 ft (61 m). A T-intersection of two corridors or walks is an 

acceptable passing place. 

4.3.5 Head Room 

Accessible routes shall comply with 4.4.2. 

4.3.6 Surface Textures 

 The surface of an accessible route shall comply with 4.5. 

 

 137

http://www.access-board.gov/adaag/html/adaag.htm#4.13.5
http://www.access-board.gov/adaag/html/adaag.htm#4.13.6
http://www.access-board.gov/adaag/html/figures/fig7a.html
http://www.access-board.gov/adaag/html/figures/fig7a.html
http://www.access-board.gov/adaag/html/figures/fig7b.html
http://www.access-board.gov/adaag/html/adaag.htm#4.4.2
http://www.access-board.gov/adaag/html/adaag.htm#4.5


4.3.7 Slope  

An accessible route with a running slope greater than 1:20 is a ramp and shall 

comply with 4.8. Nowhere shall the cross slope of an accessible route exceed 1:50. 

4.3.8 Changes in Levels. Changes in levels along an accessible route shall comply with 

4.5.2. If an accessible route has changes in level greater than 1/2 in (13 mm), then a curb 

ramp, ramp, elevator, or platform lift (as permitted in 4.1.3 and 4.1.6) shall be provided 

that complies with 4.7, 4.8, 4.10, or 4.11, respectively. An accessible route does not 

include stairs, steps, or escalators. See definition of "egress, means of" in 3.5. 

4.3.9 Doors. Doors along an accessible route shall comply with 4.13. 

4.3.10  Egress 

 Accessible routes serving any accessible space or element shall also serve as a 

means of egress for emergencies or connect to an accessible area of rescue assistance. 

Appendix Note 

 

4.26.3 STRUCTURAL STRENGTH.  

The structural strength of grab bars, tub and shower seats, fasteners, and mounting 

devices shall meet the following specification:  

1. Bending stress in a grab bar or seat induced by the maximum bending 

moment from the application of 250 lbf (1112N) shall be less than the 

allowable stress for the material of the grab bar or seat. 

2. Shear stress induced in a grab bar or seat by the application of 250 lbf 

(1112N) shall be less than the allowable shear stress for the material of the 
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grab bar or seat. If the connection between the grab bar or seat and its 

mounting bracket or other support is considered to be fully restrained, then 

direct and torsional shear stresses shall be totaled for the combined shear 

stress, which shall not exceed the allowable shear stress. 

3. Shear force induced in a fastener or mounting device from the application 

of 250 lbf (1112N) shall be less than the allowable lateral load of either 

the fastener or mounting device or the supporting structure, whichever is 

the smaller allowable load. 

4. Tensile force induced in a fastener by a direct tension force of 250 lbf 

(1112N) plus the maximum moment from the application of 250 lbf 

(1112N) shall be less than the allowable withdrawal load between the 

fastener and the supporting structure. 

5. Grab bars shall not rotate within their fittings. 

4.27 Controls and Operating Mechanisms. 

4.27.1 General 

 Controls and operating mechanisms required to be accessible by 4.1 shall comply 

with 4.27. 

4.27.2 Clear Floor Space 

  Clear floor space complying with 4.2.4 that allows a forward or a parallel 

approach by a person using a wheelchair shall be provided at controls, dispensers, 

receptacles, and other operable equipment.  
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4.27.3 Height 

 The highest operable part of controls, dispensers, receptacles, and other operable 

equipment shall be placed within at least one of the reach ranges specified in 4.2.5 and 

4.2.6. Electrical and communications system receptacles on walls shall be mounted no 

less than 15 in (380 mm) above the floor. 

1. EXCEPTION: These requirements do not apply where the use of special 

equipment dictates otherwise or where electrical and communications 

systems receptacles are not normally intended for use by building 

occupants.  

4.27.4 Operation.  

 Controls and operating mechanisms shall be operable with one hand and shall not 

require tight grasping, pinching, or twisting of the wrist. The force required to activate 

controls shall be no greater than 5 pounds of force. 
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APPENDIX I 
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